
Chapter 1 
Product Overview  
 
 
 
 
 
 
AutoQuant Pro© is a powerful, automated, multi-component, quantitative 
analysis program for use in analyzing gas, liquid and solid phase samples.  

The program provides a comfortable user interface for operating a MIDAC 
FTIR analyzer, creating analytical methods to compute compound 
concentrations and automating data collection for multiple sample stream 
installations. 

In continuous monitoring, mobile, and process applications, the program can 
display and update,  in near real-time, the quantitative results, concentration 
vs. time plots, and generated spectra.  The software provides for multi-level 
alarms, can output results and alarms to analog or digital devices, trigger 
external devices, and can  archive  and export spectra and quantitative results 
to spreadsheet software. 
 
 
 
A Crash Course in FTIR 
 
Fourier transform infra-red spectroscopy (FTIR) utilizes the absorption of 
infra-red radiation at discrete frequencies by analyte molecules.  Absorption 
and emission of infra-red radiation is associated with transitions between 
vibrational / rotational energy levels in a molecule.  A molecule is infra-red 
active if it possesses modes of vibration that cause a change in dipole 
moment.  This means that monatomic and homonuclear diatomic species 
(N2, O2, F2, H2, Cl2, etc) are infra-red inactive.  This is an advantage 
because ambient molecular nitrogen and oxygen would quickly “blind” the 
FTIR.  The magnitude of the absorption of radiation is proportional to the 
number of molecules in the beam path, and hence proportional to the 
concentration of each absorbing species.  The schematic diagram in Figure 
1.1 illustrates this principle. 
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Figure 1.1  Schematic Absorbance Diagram 
 
Where I0 is the initial intensity of the radiation and I is the radiation 
attenuated by the amount absorbed by the sample being a solid, liquid, or 
gas.  In order to determine the concentration of absorbing species we must 
first measure I0 through an empty sample cell.  This measurement creates a 
background spectrum.  Once we have a background spectrum we can fill the 
sample cell and record a sample spectrum.  The ratio I / I0  (sample / 
background) is called the transmission spectrum.  The transmission spectrum 
plots the fraction of the emitted radiation reaching the detector on the y-axis 
with wavenumbers (1/cm) on the x-axis.  A transmission spectrum is shown 
in Figure 7.4 in Chapter 7.  The transmission spectrum is related to the 
concentration of absorbing species logarithmically.  An absorbance spectrum is 
generated by taking the log10 of (1/T), where T is the transmission.  The 
absorbance is linearly related to concentration (subject to limitations 
discussed later in this section), and it is the absorbance that is used to 
determine the concentration of analytes.  The relationship between 
absorbance and concentration is given by the Beer – Lambert law: 
 

Ai = ei Ci l 
 
Where Ai is the absorbance of the ith component, ei is the absorption coefficient 
(a constant at each frequency for each molecule) of the ith component, C is 
the concentration of the ith component and l is the distance that the radiation 
travels through the sample, known as the pathlength. 
 
The above discussion applies to monochromatic radiation (radiation of a single 
wavelength).  However, we need to look at a wide range of wavelengths in 
order to build up a spectrum.  Early infra-red  spectrometers used diffraction 
gratings and apertures to select one wavelength at a time.  This method is 
slow and subject to large uncertainties in the x-axis values.  As computing 
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power increased it became possible to generate infra-red spectra using 
interferometry.  A schematic diagram of an interferometer is given in Figure 1.2. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 1.2  Schematic diagram of an interferometer 
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In an interferometer, radiation from a source is collimated and guided to a 
beamsplitter.  A portion of the beam is reflected onto a fixed mirror, while 
the rest travels through the beamsplitter to a moving mirror.  Both these 
beams are reflected back to the beamsplitter where they are recombined.  At 
this point the beam may either pass through the beamsplitter and travel back 
to the source, or be reflected to the detector.  Of the two paths to the 
detector, one is fixed while the other is varied by the distance traveled by the 
moving mirror as it scans back and forth.  As the moving mirror travels 
through distances which are integer multiples of the radiation wavelength the 
interference at the recombined beam is completely constructive.  The 
distance the mirror travels determines the resolution of a spectrum.  A 0.5 
cm-1 resolution accounts for a data point every 0.241 wavenumbers and over 
32,000 data points in the interferogram.  The opposite is true when the path 
is a half integer multiple of the wavelength, that is to say the interference is 
completely destructive.  As well as integer and half integer multiples, the 
distance traveled by the beam will also pass through every fractional multiple 
of the wavelength. This results in an interference pattern, known as an 
interferogram.  A simplified interferogram is illustrated in Figure 1.3. 
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Figure 1.3  Simplified Interferogram  
 
Figure 1.3 shows three cosine waves and their sum, offset by three signal 
units for clarity.  An actual interferogram is more complex, with the 
amplitude decreasing with distance from the ZPD burst as shown in Figure 
1.4. 
 

 
Figure 1.4  Actual Interferogram 
The large peak at the center of the interferogram corresponds to the point at 
which the moving mirror and the fixed mirror are in such positions that all 
wavelengths of the radiation are in phase and thus constructive.  This point is 
known as zero path difference or ZPD.   The radiation reaching the detector 
contains ‘encoded’ information about all other wavelengths.  This 
information can be recovered using a Fourier transform.  The Fourier 
transform of an interferogram is called a Single Beam spectrum.  While a 
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full description of a Fourier transform is beyond the scope of this user 
manual, the technique may be used to convert data from the time domain 
(interferogram) to the frequency domain (spectrum).  Before a Fourier 
transform is performed however, it is necessary to take into account a 
disconnect between theory and practice.  In theory the Fourier transform is 
integrated over the limits - ∞ to + ∞.  In practice of course, the moving 
mirror can only travel a finite distance.  This means that the start and end of 
the interferogram introduce anomaly effects in the transform.  The 
interferogram may be treated to remove artifacts caused by transforming a 
data set of finite length.  This treatment is known as apodization (from the 
Greek ‘no feet’) as the aim is to remove side lobes generated on peaks in the 
spectrum.  AutoQuant Pro© uses a function known as triangular apodization 
(default), but also offers medium Beer-Norton apodization or boxcar (no 
apodization). Once the spectrum has been treated in this way, it can be used 
with the Beer-Lambert law to determine concentrations.  There are 
limitations to consider when selecting absorbance bands to use in a 
quantitative calculation.  Consider the spectrum shown in Figure 1.5. 
 
  

 
Figure 1.5  NO2 at 8000ppm-m 
 
The band at approximately 1600cm-1 has an absorbance peak of around 1.5 
units.  Converting this to transmission we find that only 3% of the initial 
radiation reaches the detector. When  transmission drops to approximately 
10%, the instrumental resolution begins to cause a loss of information.  This 
translates as an apparent loss of linearity in the Beer-Lambert law.  In an 
analysis, the band at 2900cm-1 should be used, as more than 50% of the initial 
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radiation arrives at the detector. The real problem is the use of certain 
detectors that can exhibit non-linear tendencies when too many photons are 
striking the detector.  The detector linearity can change with total photon 
flux.  Some detectors are more linear than others.  Some non-linear detectors 
are the MCT and some linear detectors are DTGS and InSb. 
 
The entire process of data acquisition and processing is summarized in 
Figure 1.6. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 1.6 Summary of FTIR Data Generation 
 
 

1) Background and sample interferograms are recorded  
2) The interferograms are Fourier transformed from the time 

domain to the frequency domain 
3) The sample single beam spectrum produced has its ratio 

performed point by point against the background single beam to 
produce a transmission spectrum 

4) The negative logarithm of the transmission spectrum yields the 
absorbance spectrum.  The absorbance is linearly related to 
concentration. 
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A note about signal to noise: 
 
There are many factors that impact on signal-to-noise in an FTIR spectrum.  
Electronic, mechanical and optical sources all produce noise in a spectrum.  
The two most significant factors under the control of the user are the 
resolution at which the spectrum is recorded and the time spent collecting 
data for that spectrum.  High resolution spectra are inherently noisier than 
low resolution.  This can be explained in terms of the interferogram.  
Consider Figure 1.4. In a very low resolution spectrum, the interferogram 
would consist of the area around the ZPD and little else.  The signal in this 
region is very strong, and so signal to noise is high.  In order to record higher 
resolution spectra however it is necessary to use data further out on the 
wings of the interferogram.  The further out on the “wings” we travel, the 
higher the resolution but the lower the signal, and noise has larger effects on 
the quality of the data.  The second user controllable parameter affecting 
signal to noise is the integration time (or number of co-added scans used to 
create the interferogram).  As the time interval  over which the interferogram 
is recorded doubles, the signal to noise improves by a factor of the square 
root of 2. This is discussed further in Chapter 6.  However, bear in mind that 
S/N is really a function of the time scanning.  The longer time scanning, the 
better the signal to noise ratio.  The MIDAC spectrometer is truly integrating 
and will provide improved signal to noise by increasing the number of scans 
and thus time scanned.  It is not unusual for users to scan one sample for 
many minutes to provide extremely low noise signatures.  The MIDAC 
spectrometer is truly only detector noise limited. 
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File Compatibility: 
 
Spectral files collected in AutoQuant Pro© are compatible with Grams file 
formats (.spc).    

Additionally, the MIDAC software package AutoQuant Pro© provides fully 
automated control for long-term continuous data acquisition over multiple 
sample streams. Together, the suite of software can control multiple valving and 
pump configurations and can automatically collect background spectra, 
calibration spectra, and data from multiple sample lines and/or pumps, switches, 
and valves up to presently 60. Data are organized automatically in subfolders with 
their own respective results file and can be stamped according to date and time 
(down to the millisecond) of acquisition or sequentially numbered. Sockets 
technology and command line operations allow interfacing with other software 
packages or custom programs for remotely starting and stopping collections or 
sending spectral data. 

The AutoQuant Pro© software is based on a C++ platform for stability and 
high-speed execution of most arithmetic and collect functions.  

This approach gives MIDAC users tremendous flexibility in the development of 
custom routines for process, environmental, or QA/QC-type applications. 
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Chapter 2 
Installation and Setup  
 
 
AutoQuant Pro© software can be installed on any desktop or notebook PC that 
runs MS-Windows 2000 or higher operating system software.  

System Requirements 
The PC must meet the following minimum hardware requirements: 

� Pentium III or higher CPU (800 Mhz or higher) 

� At least one free PCI or PCMCIA slot that the computer can assign 32 
bits of memory allocation 

� VGA or display with 1024 x 760 resolution 

� At least 128mb RAM (256mb or more recommended) 

� At least 20 Gb hard drive, with at least 50mb free space for installation of 
software 

� Significant additional free disk space for method calibration files and for 
data collection 

� R/W CDROM for installing software and archiving data 

� Windows 2000 Professional operating system with latest service paks.  
AutoQuant Pro© will run on other platforms although Windows 2000 is 
preferred 

� Mouse or other pointing device 

. 

Installing the Hardware: 
 
Interface Card 
The system requires a proprietary spectrometer interface card (which is 
shipped from the MIDAC factory with each instrument) to handle 
communication between the spectrometer and computer.   
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Two types of interface cards are used: PCI cards for desktop computers and 
PCMCIA cards for notebook computers.  These cards require a proprietary 
software device driver that’s compatible with the interface card and with the 
type of electronics used in your particular spectrometer (either single ADC or 
dual ADC). 
 
If you are uncertain which type of ADC your system contains, check the 
original packing list and/or sales documentation, which should specify Single 
or Dual ADC in the description.  A general rule is that most systems shipped 
prior to May 2002 are equipped with Single ADC electronics; while most 
shipped after that date are equipped with Dual ADCs.  However, there are 
some exceptions.  If you are unable to determine by any other means, the 
type of A/DC is printed on the circuit board inside the spectrometer.  Refer 
to your Operator’s Manual or MIDAC’s service department (714) 546-4322 for 
appropriate cautions and procedures before opening the spectrometer to 
check. 
 
 
Installing the Software 
 

1. With MS-Windows running, close all application programs before 
installing   the AutoQuant  Pro© software package. 

 

2. Place the AutoQuant  Pro© CD in your CD-ROM drive. Click the 
Start  button on your Windows taskbar, then select Run. 

 

3. Type the drive designator for your CD-ROM drive plus the term  
setup_aq4  in the space provided.  

For example: 

d:\setup_aq4    or    e:\setup_aq4  

(Or click on the Browse button and find the setup_aq4.exe file on the CD).  

4. Follow the directions provided on the program screens to progress 
through the software installation.   
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When the setup program has finished, the AutoQuant Pro© icon will appear 
on the screen, and the AutoQuant  Pro© software will appear under 
Programs on your Start menu. 
 

5. 

6. 

1. 

2. 

3. 

4. 

If you’ve installed the software on the computer of an existing FTIR  
system that is fully functional and able to collect data (i.e., via Grams 
software), your installation is complete.  There’s no need to install a 
new device driver.  If you are updating your AutoQuant Pro© 
software to a newer version, simply install over the previous version.  
No data or methods will be overwritten.  

 
To run the software, double click on the desktop icon or select Start 
>> Programs >> AutoQuant >> AutoQuant Pro©. 

 
If you are changing computers or installing a new system, you’ll need 
to install your spectrometer/data system interface card and the 
appropriate device driver, as described below. 

Device Driver Software 
 
The simplest way to install the appropriate device driver is to turn off the 
computer, install the interface card in the appropriate expansion slot, turn the 
computer back on, and let MS-Windows automatically detect the hardware 
and install the driver. You’ll then be prompted to provide the information 
described below. 
 
Alternatively, you can open the MS-Windows “Control Panel” and select 
the “Add/Remove Hardware” option to start the installation process.  When  
you select “Add/Remove Hardware” you will activate the Installation 
Wizard.  

 
Following are the steps for use with the MS-Windows 2000 Installation 
Wizard: 

On the “Choose a Hardware Device” screen, select “Add a new 
device.” 

 
On the next screen, “Find New Hardware,” select “No, I want to 
select hardware from a list.” 

 
On the next screen, “Hardware Type,” select “Other devices.” 

 
On the next screen, “Select a Hardware Driver,” click on “Have      
Disk” button. 
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5. When the “Install From Disk” dialog box appears, select “Browse” 

and locate the directory on your hard drive where the appropriate 
driver is located.  

  
Note   All driver names are identical, so you MUST select the driver from 
the proper directory. By default, AutoQuant Pro© is installed under 
“Program Files.” 
 
The individual driver directories are located under the “drivers” subdirectory 
under the Autoquant4 program as follows: 
 
C:\Program Files\AutoQuant4\drivers\single_pci (for the single ADC  PCI 
board) 

C:\Program Files\AutoQuant4\drivers\single_pcmcia (for the single ADC 
PCMCIA board) 

C:\Program Files\AutoQuant4\drivers\dual_pci (for the dual ADC  PCI 
board) 

C:\Program Files\AutoQuant4\drivers\dual_pcmcia  (for the dual ADC  
PCMCIA board) 

Once the AutoQuant Pro©© software and the spectrometer device driver 
have been installed, reboot the computer.  

To run the software, double click on the desktop AutoQuant Pro© icon or 
select Start >> Programs >> AutoQuant >> AutoQuant Pro©.  You’re 
ready to go. 
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Chapter 3 
Getting Around the Menus 
 
 

The AutoQuant Pro© display is rich with information and features, 
providing the familiar feel of many Windows applications.  
 
You can operate the software via menus, graphic toolbars, push buttons, or a 
combination of all three, depending on how you like to work.   
 
The program and its displays are designed to match the flow of your work, 
from setting up the instrument to defining an analytical method, activating 
data collection, and displaying results. 
 

 
Figure 3.1  Main Sections of Screen  
 
 
Menu Bar 
 
The menu bar along the top of the display provides access to all the major 
program functions.  Item-by-item descriptions are provided in Chapter 5. 
 

 
Figure 3.2  Main Menu Bar 
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The menu items on the main menu bar are as follows: 

 

File Provides all basic file operations for handling defined methods 
such as loading, saving, importing, and opening new methods. 

Instrument Provides the means for configuring the instrument prior to 
data collection as well as basic instrument controls. 

Method Provides a variety of functions useful in building your analytical 
method as well as method file handling utilities. Automatically 
opens the “Method Screen” when a menu item is selected. 

Analyze       Provides information entry to configure and to initiate single, 
continuous or high-speed data collection runs.  Automatically 
opens the “Analyze Screen” when a type of data collection is 
selected. 

Batch Provides the means for reprocessing stored data.  Useful for 
implementing method refinements and adjustments. 

Tools A collection of useful tools including instrument setup 
parameters, spectral search, library and alarm functions. 

View Provides for selection and de-selection of toolbars to 
customize the AQ Pro display according to individual 
preferences. 

Help Access to Help files and software version information. 

 
Toolbars Graphic toolbars can be used as an alternative or supplement 

to the main menu bar. Use the View menu to select toolbars 
you wish to display.  

 
Some users prefer the easy “single click” access to functions provided by the 
toolbars; others prefer the added display area without them. 
 
The four toolbars available with AutoQuant Pro© are as follows. 
 

 
Figure 3.3  File Toolbar 
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Figure 3.4  Instrument Toolbar 
 

 
Figure 3.5  Method Toolbar 
 

 
Figure 3.6   Measurement Toolbar 
 
By default, toolbars are displayed along the top and left sides of the screen. 
However, you can drag and place them anywhere you want. To move a 
toolbar, click on its handle (or an inactive area around the icons), then hold 
down the left mouse button while moving the toolbar to the desired location. 
 
To remove a toolbar, position the cursor over any part of the toolbar area 
and right click your mouse.  Uncheck the toolbar you want to remove.  You 
can also do this via the View menu.  Similarly, to display a hidden toolbar, 
click the desired selection on the list.  A check will appear next to the item, 
and the toolbar will be displayed.  You can then arrange the toolbars as you 
please. 
 
One special toolbar icon is the red Stop Sign that appears near the upper left 
corner by default.  Use the Stop Sign icon to terminate any data collection 
activity in progress (the same function is provided by the Stop button on the 
Instrument screen). Although you can move the Stop Sign icon around, or 
remove it entirely, we recommend that you keep it displayed where you can 
access it conveniently.   
 
Screen Tabs and Push Buttons 
The four primary display screens (Instrument, Method, Analyze, and Results) 
are accessed by the four tabs near the upper left corner of the display.  They 
are automatically displayed when certain menu or toolbar items are selected.  
The screens are presented in the order in which tasks are usually performed – 
starting with the Instrument screen.   
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Figure 3.7  Instrument Screen With Toolbars Displayed 
 
Pushbuttons on this screen (and the other three main screens) let you 
perform essential functions with a single click.  They duplicate the 
functionality of most key toolbar icons, so that you can still have single-click 
operation — even when you hide toolbars to gain greater display area.  
Buttons for each screen will be described in detail in the next chapter. 
 
The primary focus of the four main screens is: 
a) Spectral display on the Instrument Screen 
b) Reference spectra file information on the Method Screen 
c) Spectral display/trend chart/concentration table on the Analyze Screen 
d) Report table for collected data on the Results Screen 
 
Information and Status Lines 
 
The two lines at the bottom of the AutoQuant Pro© display screen provide a 
convenient reminder of the currently chosen analytical method, instrument 
status and data collection parameters.  
 

 
Figure 3.8  Information and Status Lines 
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For example, Figure 3.8 shows the lower portion of the spectral display 
window.  File information for the displayed spectrum appears just above the 
Information and Status Lines.  At the far left of the upper Information 
Line, you see “ex2\ex2”.  This is the directory location and the name of the 
currently active method.  Moving to the right, “D:\AQdata” indicates the 
directory chosen for storage of collected data.  Continuing to the right, 
“2048MB Free” indicates the amount of available hard disk space remaining.  
The last three fields indicate current data collect settings for scan sets, 
resolution and gain. 
 
The lower Information Line in Figure 3.8 starts with “Ready”, indicating 
that the spectrometer is connected and ready to collect data.  Moving to the 
right, “DEMO” is the type of instrument connected (usually this will include 
the type of interface card and A/D processor).  The final two fields are the X 
and Y axis values for the current cursor position in the spectral display 
window. 
 
Right Mouse Click Functions 
A primary goal of AutoQuant Pro© is to let you be as efficient as possible.  
This includes minimizing the amount of time you spend looking for tools 
within the program and maximizing the time you spend intelligently building 
and implementing your analytical methods.  In keeping with this goal, the 
right mouse button provides quick access to features directly related to where 
you are onscreen. 
 

 
Figure 3.9  “Right-Click” Menu 

 
This “context sensitive” feature means that a right click on the spectral 
display window brings up display manipulation tools; a right click on the strip 
chart brings up chart options; and a right click on the spectra area of the 
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method screen lets you add or view spectra without going to the Main Menu 
bar.  In short, try right clicking on the mouse wherever you are onscreen as 
the first step to quickly accomplish a task.  
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Chapter 4 
Feature Descriptions 
 
This chapter presents AutoQuant’s four major program screens.  
 
Building an accurate and robust analytical method that returns reliable 
measurements across a range of process conditions and sample 
concentrations is iterative.  AutoQuant Pro© takes you through the process 
in a logical progression of steps.  In fact, the sequence of four screens is 
designed to match your workflow through the four major tasks in obtaining 
data: 
 
1.  Configuring the instrument to fit your needs. 
2.  Selecting and collecting references to build your analytical method. 
3.  Activating data collection to analyze your samples. 
4.  Recording and displaying results of the analysis. 
 
Chapter 5 provides an item-by-item walkthrough of each menu/toolbar on 
the four screens. Most AutoQuant Pro© functions can be accessed in any of 
three ways (via pushbuttons, menus, or toolbar icons) with identical results. 
 
The Instrument Screen 
 

 
Figure 4.1  Push Buttons on the Instrument Screen 
 
The Instrument screen includes eleven pushbutton controls, as shown in 
Figure 4.1. 
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The Align Button 
This button allows viewing of the interferogram signal levels as you align the 
fixed mirror to optimize performance.  When pressed, Align will immediately 
begin continuously collecting and displaying either interferograms, single 
beam spectra or both, (as shown below), depending on the display format 
selected. 
 

 
 

 

     

Figure 4.2   Align Screen Display Formats 
 
You may choose whether the interferogram signal is displayed in voltage or 
data bit format.  The purpose of alignment is to maximize signal at the 
detector without overflowing the ADC capacity.  Since the interferogram is 
rarely symmetrical at the centerburst, alignment should be done by observing 
both the singlebeam spectrum and the minimum or maximum signal value, 
whichever is greatest in absolute value.  The singlebeam spectrum allows the 
user to optimize the signal in the more difficult to obtain higher energy areas 
above 2800 cm-1.  Additionally, the absolute value of the Max OR Min 
                                                    20 



should fall between 70% and 90% of the A/DC capacity (this translates to 
approximately 23,000 – 29,500 data bits, or 1.75 – 2.25 Volts).   The Min, 
Max, and Peak-to-Peak values are displayed in large red characters on the 
Align screen for easy reference as you adjust the fixed mirror.  Please refer to 
subsequent chapters for alignment procedures. 

Note:  Newer Dual ADC systems do not need the ADC to be nearly 
saturated for good signal to noise ratios.  A max or min number of above 
8000 is adequate but maximizing the signal is better for high moisture 
streams. 

The Align screen also allows you to overlay signals on the display for a visual 
record of stability and changes over time.  Each subsequent scan will be 
superimposed over previous data in a different color. Data are also displayed 
in tabular form on the lower left. 
 
The Sample Button 
This button initiates collection of a sample spectrum and displays the results.  
If a method is defined and active, the data will be collected according to 
parameters specified within the method.  If not, the instrument will use 
default parameters to collect the spectrum. A reminder of the settings 
currently in use appears just under the Parameters button above the spectral 
window. 
 

 
Figure 4.3  Sample Screen Display 
 
Data collection progress is displayed on the upper Information Line, (near 
the screen bottom), as scans are collected and co-added.  Both a scan count 
and graphic bar are provided.  Note that the information contained within 
the memo field (see parameters discussion) is displayed both within the 
spectral window and below it. 
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The Background Button 
This button initiates collection of a background reference spectrum and 
displays the resulting single beam.  Operation is the same as described for the 
Sample button above. 
 

 
Figure 4.4  Background Screen Display 
 
The Stop Button 
This button terminates a data collection in progress (same function as the 
stop-sign icon). 
 
 
The Re-Initialize Button 
This button is used to re-establish interrupted communication between the 
computer and spectrometer.  It is used if the instrument has lost power, been 
disconnected or has otherwise been taken off line. 
 
The Cal Scan Button 
This button initiates a data collect scan for the purpose of locating the Zero 
Path Difference (ZPD) of the interferogram.  The ZPD occurs when the 
fixed and moving mirror are at the exact same distance from the 
beamsplitter, resulting in perfect constructive interference.  Accurate 
identification of the ZPD is essential when co-adding scans.  The Cal Scan 
function is only used if some problem is encountered in collecting data; it is 
not used during routine operation. 
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The Parameters Button 
This button is used to access settings for virtually all aspects of software 
operation and instrument configuration. 

 
 
Figure 4.5  Parameters: Scanning Display 
 
Parameters: Scanning 
 
Note:  One sample spectrum is usually comprised of a number of scans.  
One scan represents one completion of the mirror travel.  Scans are usually 
co-added to improve signal to noise. 
 
Sample Scans - Select the number of scans to be co-added for the sample 
spectrum.  The number of scans may be selected from a drop down menu in 
powers of 2, up to a maximum of 256 scans.  Alternatively, any number of 
scans may be entered manually.  (Note: more scans results in better S/N) 
 
Sampling Interval - Applicable only to continuous monitoring mode.  If 
“As fast as possible” is checked, the system initiates a new set of scans 
immediately after the current set is complete.  If the box is not checked, an 
interval of seconds, minutes or hours can be specified.  The system will 
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collect a scan set, suspend data collection for the specified interval, then 
collect the next scan set automatically.  
 
Background Scans - Select the number of scans to be co-added for the 
background reference spectrum (from 1-256), but as with the sample scans 
any number may be entered manually. (Note: hundreds of scans are not 
unusual but time constraints usually limit the number to 8, 16, 32, or 64 
scans) 
 
New Background Prompt - You can specify a prompting interval.  If the 
current background is older than this interval, a prompt will appear 
informing the operator that a new background is indicated.  However, if the 
system is in continuous mode, data collection will continue unabated unless 
you respond to the prompt.  When the prompt appears, you have the option 
to ignore it, or to pause the data collection while you collect a new 
background.  The software will use the last background collected in 
processing samples unless the user specifies otherwise. 
 
Resolution - Select the wave number resolution of any collected data (from 
32-0.5).  It is important to remember that your sample resolution MUST 
match the resolution of both the background spectrum and the reference 
spectrum used for compounds included in your method. 
 
Save Region From/To - These parameters allow you to adjust the range of 
data saved for each measurement to more closely match the spectral features 
of interest.  This can help conserve disk space and possibly improve data 
quality by discarding information in unused spectral regions, or in areas 
outside the detector’s usable range.  Some examples: a range of 400-4000 is 
standard for general use with a DTGS detector and KBr optics; a range of 
650-4500 is appropriate for general use with an MCT detector and ZnSe 
optics. 
 
Apodization - Select the method of apodization applied to interferograms 
during the Fourier processing (see the introduction to FTIR in Chapter 1).  
Boxcar is essentially the same as no apodization and is only recommended 
for experienced spectroscopists.  Triangle produces the least noise of the 
options, and is the apodization used for MIDAC spectral libraries.  Norton-
Beer medium most closely approximates the real shape of gas phase spectra.  
MIDAC recommends triangular for best performance. 
 
Phase Correction – Interferograms are rarely perfectly symmetrical about 
the centerburst (ZPD).  This is mainly due to frequency dependant phase 
shifts introduced by the beamsplitter materials and the electronics used to 
process the signal.  Each frequency of the light entering the interferometer 
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results in a cosinusoidal output.  The frequency dependant phase shifts 
introduce sinusoidal components to the interferogram, causing the 
asymmetry.  It is these sinusoidal components that are removed by the phase 
correction algorithm.  AutoQuant Pro© offers two such algorithms: Mertz 
and Amplitude.  Mertz phase correction is the preferred setting for 
computing absorbance spectra in most applications. 
 
Gain (Hardware) – This is set using the jumpers on the detector preamp 
board, and controls the amount of amplification applied to the interferogram 
signal before it is processed by the ADC.  For best results, the gain should be 
set so that the interferogram center burst is between one-half scale and full 
scale at its most extreme point.  If the gain is set too high, the signal may 
overflow the ADC; if set too low you will not take full advantage of the 
analyzer’s sensitivity.  It is not recommended for customers to change the 
gain settings on the detector preamp, as signals from photo-diodes have a 
large offset, and increasing gain without proper monitoring of the detector 
preamp may result in signal clipping which would not be apparent on 
inspection of the data. 
 
Gain (Software) – This is set using the software and amplifies the signal 
from the ADC to the computer. 
 
Parameters: Align Mode 
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Figure 4.6  Parameters: Align Mode Display 
 
The Align Mode  setting on the Parameters menu lets you select the 
resolution for interferogram or single beam spectra that will be displayed 
during fixed mirror alignment and the format in which the data will be 
displayed on screen.  Alignment should usually be performed at low 
resolution (i.e., 16 or 32cm-1) for speediest display updates and minimal delay 
in viewing effects of mirror adjustments.  You may choose to display 
interferograms, single beam spectra or a dual screen with both formats. 
 
Parameters: Method 

 
Figure 4.7:  Parameters: Method Display 
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Linearity - Specify whether the method is linear or non-linear.  Linear 
methods use only one reference spectrum for each compound (0,0 and the 
spectrum chosen as the primary spectrum). Non-linear methods use all of the 
reference spectra and can use up to 32 reference spectra for each compound.  
Much greater accuracy is achieved by using non-linear mode as all of the 
reference spectra are used in the calibration.  The spectrum selected as 
primary is used for the linear method but does not matter in a non-linear 
calibration.  Applications in which a relatively small dynamic range of 
concentrations (say within a factor of ten, with sample concentrations 
ranging from 2 to 20%, for example) tend to be linear, and so may be 



represented by a single spectrum.  Wider dynamic ranges of concentration 
often encounter non-linearity, so multiple reference spectra spanning the 
anticipated range of concentrations are required for accurate results.   
 
Note   Once all reference spectra in a method have been defined, you can 
use the View Linearity function on the Method menu to determine the 
degree of linearity of a calibration curve.  An excessively non-linear curve (i.e. 
one in which the gradient at the high end approaches zero) is an indicator 
that different regions of analysis should be selected.  It is important to note 
that the 1st and 2nd order polynomials fitted to the data in the View Linearity 
function are solely for the purposes of outlier detection, and in no way 
represent the proprietary algorithm that performs the quantitative analysis.  
In other words, those numbers are not the same as the numbers reported by 
the true AQPro CLS algorithm. 
 
Baseline Correction –  
If None is selected in this area, all spectral information down to 0 
absorbance units is used.  This should only be used for sample and reference 
spectra that exhibit very clean baselines.  Since most FTIR analyzers produce 
some slope or offset of their baselines, this setting is not recommended. 
 
Offset can be selected for spectra that do not exhibit any slope to the 
baseline.  However, Linear is the recommended baseline correction setting 
for most applications. 
 
Linear is the recommended baseline treatment for virtually all sample and 
reference spectra (both with and without slopes and offsets).  Any baseline 
slope is automatically corrected in the CLS algorithm for both sample and 
reference spectra. 
 
 

The Embedded Baseline Correction should always be set to ON, (the box 
should be checked).  Although the setting can be turned OFF for backward 
compatibility with previous AQ3 methods, analytical performance is not 
guaranteed with this setting.  Therefore, we strongly recommend that this 
setting remain ON, even when working with imported AQ3 methods. 
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Calibration - On-the-fly non-linear calibration checkbox is used primarily 
to accelerate the method development adjustment and testing process.  If 
this box is checked, AQ Pro will only calculate sub-methods when they are 
actually required for analysis.  Since some non-linear methods may have 
thousands of sub-methods, this setting eliminates the delay of calculating all 
these possible but probably unnecessary sub-methods. 



A full calibration, (with the On-the-fly setting OFF) calculates every possible 
sub-method (combinations of every reference spectrum for every 
compound) regardless of whether they are actually encountered in the 
measurement.  A full calibration is highly recommended once a method is 
determined to meet the required analytical performance.  To cut out 
unnecessary sub methods when conducting analyses it is recommended that 
you use the Large Methods Optimization check box.  
 
The Quadratic baseline correction is only available with Embedded 
Baseline Correction turned ON.  It can accommodate spectra with broadly 
curving baselines. 
 
Exclusion Criterion - This parameter determines the cross interferences 
within a given region that are included or excluded from concentration 
calculations.  The larger the number entered in this field, the more 
interferences will be included in the sub-method.  The lower the number 
entered, the more discriminating the program becomes and fewer 
interferences are included.  We recommend that this setting be left at its 
default value of 2500.   
 
The exclusion criterion is the ratio of the sums of the squares of the data 
points over the analysis regions for the target compound and any 
interferences.  If this ratio is greater than the criterion, interference is 
minimal, and the interferences are excluded from that particular sub-method. 
 
NOTE:  Occasionally, a sample matrix spectrum will exhibit characteristics 
that cause the software to “exclude” fine small absorbance bands in the CLS 
algorithm.  When this occurs, an interfering species may not be “subtracted” 
from the spectrum causing an interference problem and a high reported 
standard error calculation (SEC) number.  This can be determined by 
observing the generated residual spectrum in AQPro to determine if all 
interfering absorbance bands are being subtracted.  If they are not, such as 
some water bands, it may be necessary to increase the exclusion criterion 
number to a point that the inclusion of the interfering species is performed.  
It may be necessary to raise the exclusion number to over 1 million for these 
special applications.   
 
Pre-processing - The 1st derivative setting is for use in specialized 
applications and should usually be unchecked unless very low ppb levels are 
encountered.  This condition is most likely to occur when conducting 
analysis with specialized hardware such as band pass filters and halogen 
sources.  The new HydroQuant setting is activated to use a dynamically 
calculated synthetic background spectrum for analysis.  This option is 
frequently used for moisture analysis and other specialized gas applications.  
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The K factor is a smoothing function applied to the synthetic HydroQuant 
background.  Larger K factor values result in more smoothing.  A full 
description of the Hydroquant software may be found in Appendix 3. 
 
Single Beam Quant (SBQ)-  Single beam quant is a powerful tool for 
performing true transmission spectroscopy or utilizing a synthetically user 
derived background spectrum for both extractive and open-path use.  In 
SBQ, the software will automatically draw a straight line between the 2 
endpoint chosen for quantification in the method editor.  For example, if a 
user wants to measure CO2 and is unable to get a clean background, the user 
selects the 2 endpoints of the single beam spectrum that closely approximate 
the amplitude of the baseline on either side of the transmission bands.  The 
software will then draw a line between those 2 endpoints and use the 
resulting single beam spectrum as the newly generated synthetic background 
spectrum.  It is an automated zapping procedure.  By careful use with 
computed compounds, the user can determine compound ratios, peak-
heights, integrations, and true transmission spectroscopy.  It is extremely 
useful in applications where FTIRs are mounted with windows onto reactors 
to monitor reactor vessel processes, optimizations, and endpoints. 
 
Interpolation - Pair-wise Linear may be used for applications with one or 
two target compounds and little interference.  Piece-wise interpolation has 
been shown to deliver superior results in more complex methods with more 
interference.  Piece-wise is the default setting.  Piece-wise should always be 
used for daily operations and complex matrices. 
 
Gas Cells – The Gas Cells check box allows the user to select which of two 
gas cells to use in a method, for example, a user may wish to use a short 
pathlength for high concentrations and a long pathlength for a low 
concentration. 
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Parameters: Storage 

 
 
Figure 4.8:  Parameters: Storage Display 
 
 
Settings on this screen let you specify which spectra are stored, no spectra are 
stored or stored only when preset alarm thresholds are exceeded.  The Save 
Abs. On Alarm setting is useful for diagnosing concentration excursions. 
You can also direct the system either to stop storing data or to replace the 
oldest data to allow analysis to continue if disk space ever becomes critically 
low. 
 
The Storage setting on the Parameters menu is provided for data 
management when the system is operated in continuous measurement mode.  
Continuous monitoring can generate very large amounts of data, consuming 
storage capacity on even large hard drives if left unattended or unmanaged 
for long periods of time.   
 
The Switch directories every checkbox allows the user to choose a suitable 
time interval for generating a new subfolder under the current collection 
folder.  The results file for each time interval is also stored in this subfolder 
for easy data results viewing without having to re-batch data.  This feature 
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makes for organized data storage and transfer to storage media such as 
external hard drives, DVDs or cd-ROMs more manageable. 
 
The option exists to store intermediate forms of data as well as, or instead of, 
the final computed absorbance spectra.  Spectral data can be saved in 
absorbance format or as (.spc) files for automatic recognition by Grams 
software.  It is always a good idea to save the (.ifg) files (interferograms), as 
all other data types can be generated from this raw data.  Please note that the 
inteferogram is the data in its purest form and the most legally defensible 
data. 
 
Enabling Backups automatically stores a duplicate copy of each data file as it 
is generated.  The duplicate can be saved in a different directory, drive, or 
network location as a measure of insurance against lost or corrupted files.  
The duplicate data are saved in the location specified on the Parameters: 
Paths screen.  With backups enabled the results file is also saved to the 
backup directory.  If automatic directory switching is enabled then the 
backup will switch correspondingly according to the schedule set in the 
dialog.  A separate results file with extension .aqr file will be generated each 
time the directory is switched.  The results file can be viewed by clicking on 
the File tab in the uppermost toolbar and choosing “view previous 
results.”   
 
The lower area of the Parameters: Storage display is used for Continuous 
mode data collection.  Select Continuous to collect data indefinitely until the 
run is stopped manually.  Select Collect this many samples and enter the 
desired value to automatically stop data collection after the specified number 
of spectra have been acquired.  The third option is Collect for this long. 
Select this option to specify how long, (in minutes or hours), the data 
collection will run before automatically stopping. 
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Parameters: Memo Field 

 
Figure 4.9 Parameters: Memo Field Display 
 
The Memo Field setting on the Parameters menu allows the user to specify 
the annotation that will be stored with each spectrum for identification 
purposes.  Contents of the memo field are automatically tagged to each file 
saved and are displayed under and in the spectral window along with the 
spectrum itself.  To remove items from the memo field, position the cursor 
over the item you want to delete, use the left mouse button or Shift key to 
highlight the item, and press the Delete key. To add one or more items to the 
annotation, click on the menu arrow to the right of the memo field, and 
select the desired items.  The code will be automatically inserted into the 
memo line for you, depending on the parameters set in the software, and the 
values in effect at the time of data collection for those items will be stored.  
You can also change the order in which items appear by using standard 
Windows cut and paste techniques in the memo field.  The memo field is 
important as it allows other users to view a spectrum and have access to the 
parameters under which that spectrum was recorded.  This allows a user to 
duplicate previous experiments.   
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Parameters: Paths 

 
Figure 4.10  Parameters: Paths Display 
 
The Paths setting on the Parameters menu lets you specify where the 
program can find certain files, and where it should store files it creates.  
These locations can be on the same disk drive as the software, or on an 
external network-connected drive. 
 
Field 1 specifies where defined methods will be stored, and where the 
program can find a method to load.  Field 2 establishes where collected data 
will be stored.  Field 3 specifies where the program can find spectral 
reference libraries.  Field 4 specifies where backup copies of files will be 
stored when the Backup function on the Storage parameter screen is 
enabled. (See Parameters: Storage). 
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Parameters: Auto Resume 

 
Figure 4.11   Parameters: Auto Resume Display 

 
The Auto Resume setting on the Parameters menu allows a data collection 
that is interrupted by a computer power condition or reboot to resume 
automatically when the computer is restarted.  The software will re-start 
automatically and continue to collect data to the same directory used before 
the interruption.  If the power interruption occurred in the middle of a scan, 
that spectrum is discarded.  In order to set up the AutoResume function the 
administrator is required to create an account for the user.  The administrator 
must then run the 'AutoResumeSetup.exe' program located in the AQPro 
program directory and provide the same username for the account.  This 
program simply gives the designated user permission to change the registry 
so that auto-resume can be enabled and disabled by the AQPro.exe program 
when it is run under the designated user account.  On the AQPro 
Tools/Parameters/Auto-Resume tab, supply the account username and 
password.  Ensure that the 'Enable Auto-Resume' check box is checked.  
After the setup has been completed AutoResume should be tested with a 
deliberate loss of power. 
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How auto-resume works: 
When a measurement starts, (AQ4) AQPro modifies the registry: 
 
1. Sets the default user and the default password to those provided. 
2. Sets auto-logon so there is no user/password prompt when the 
   system re-starts. 
3. Sets up 'aq4 -resume' to run the next time the system starts. 
4. Disable disk auto-check so the system will restart without checking 
   the disks for corruption. 
 
If the measurement completes, these modifications are undone. 
But if the system power-cycles or is somehow rebooted before the 
measurement ends, the aq4 user will be logged in automatically, 
and aq4 will restart with the measurement. 
 
The fact that a resume happened will be logged with the results, 
and in the 'autoresume.txt' file located in autoq4\bin.  
Also "(RESUMED)" will be added to the method name in the program 
title bar.  The “RESUMED” will disappear upon starting a new collection 
type. 
 
To set up auto resume: 
 

1. 
2. 

3. 

4. 

5. 

The administrator is required to create an account for the user. 
The administrator must run the 'AutoResumeSetup.exe' program  
located in the AQPro (Autoquant4) program directory and provide 
the same username used for the account created in step 1.   This 
program simply gives the designated user permission to change the 
registry so that auto-resume can be enabled and disabled by the 
aq4.exe program when it is run under the designated user account. 
On the AQPro Tools/Parameters/Auto-Resume tab, supply the 
same username and password that were used in steps 1 and 2. 
Also on the AQPro Tools/Parameters/Auto-Resume tab, make sure 
the 'Enable Auto-Resume' check box is checked. 
Be sure to test it on each computer that you set up to do this. 
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Parameters: Analog Out 
  

 
Figure 4.12  Parameters: Analog Out Display 
 
The Analog Out item on the Parameters menu is used to configure and test 
the output of concentration or error “SEC” measurements as analog signals 
to external devices such as supervisory computers or alarm systems. Click the 
pull down menu to the right of the Analog Out Device field to select the 
type of device you want to configure. 
None is the default setting. Field Point and Modbus are currently 
supported interfaces.  Custom interfaces can be developed by calling your 
sales representative. 
Note:  an Analog In setup dialog has been added in build 108 and later 
versions of AutoQuant Pro©.  This may be used to configure analog inputs 
to the method. 
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Field Point. 
 

 
Figure 4.13  Field Point Setup Display 
 
The Field Point device is an optional interface board available from 
MIDAC.  The manufacturer is National Instruments.  You must have the 
corresponding hardware devices for the software to function properly using 
Field Point.  The two hardware devices used for 4-20 mamp output are the 
FP-AO-200 and FP-1000 modules.  Additional modules are available for 
other outputs or more channels. 
 
After selecting Field point, click on the Setup button to access the device 
configuration features illustrated in Figure 4.13.  Select the appropriate serial 
port to which the analog I/O board is connected from the pull down list in 
the Com Port  field.  Select the appropriate data communication rate from 
the pull down list in the Baud Rate field.  Now you are ready to define 
channels.  The appropriate dip switches must also be set correspondingly on 
the Field Point hardware devices. 
 
Click on the Add Row button to begin definition of a new channel.  This 
will display data entry fields as shown in Figure 4.13.  Click on the pull down 
list in the Compound column to select from compounds defined in the 
currently active method.   
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Type in the appropriate address for the device in the FP-AO-200 Address 
field.  This may be obtained from the Field Point Communications dialog 
delivered by pressing the Field point… button.  This dialog is shown in 
Figure 4.14. 
 

 
Figure 4.14  Fieldpoint communications dialog 
 
Next, select the Channel Number on the I/O board that will be assigned to 
this compound.  Up to 16 channels are available with each board.  Select the 
Current Range from the pull down list.  The first 2 are pre-assigned to 
temperature and pressure of the sample cell leaving 14 additional Inputs. 
 
Specify what type of data is being communicated on this channel 
(concentration or SEC) in the Value field.  Finally, you will associate the 
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range of measured values with the range of current output by the analog 
device.  Enter the lowest measured concentration value you want to 
communicate in the Low ppm field, and enter the highest measured 
concentration value you want to communicate in the High ppm field.  
These will be associated with the extremes of the output device (ie, 0-20 or 4-
20mA) with intermediate values scaled accordingly. 
 
Repeat this procedure for each compound you want to output.  The Re-Test 
button may be used to check for errors after each channel is configured.  
Enabling error logging via the Logging check box creates an error log that 
can be monitored. 
 
Field Point support exists for the RLY-420 module for alarms.  Field point 
alarms may be linked to sample lines.  The setup dialog for this function may 
be accessed via the valve sequence dialog (see the Valves section). 
 
All compounds listed in fieldpoint must exist in the method, for example if a 
compound name is changed then in order for the 4-20 mA output to 
function correctly the compound name must also be changed in the 
fieldpoint dialog. 
 
Modbus 
 
Select Modbus from the drop down menu.  Click on the Setup push button.  
This returns a dialog box.  Pressing the Auto Fill push button brings up a set 
of check box options.  The user can choose to include error “SEC”, create 
separate sample line entries if multiple sample lines are used and choose to 
report the sample line number being tested in register 1. 
 
Note:  The sample line number is in format n+1, for example #1 would be 
reported as #2, so #n is reported as #n+1.  All registers start at 40000 + 
register number.  The system will output all concentrations and external 
inputs, and computed compounds through modbus TCP-IP through the 
computer CAT5e interface.  Anything the user chooses to output from the 
AutoQuant Pro© generated numbers will be sent on its own register (over 
100 registers available) to a separate data acquisition system.  The output is 
32 bit floats in the modbus registers, so each value takes up two of the 16 bit 
modbus registers. 
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Figure 4.15  Modbus Auto Fill Dialog Box 
Check the options as required.  If the options selected in Figure 4.15 are 
checked, AutoQuant will deliver a table based on the compounds in the 
current method.  This table is illustrated in Figure 4.16. 
 

 
Figure 4.16  Modbus Setup 
 
The Add Row and Remove Row buttons may be used to edit the table.  
Pressing Print will print a copy of the current table.  The Test button may 
be used to check the current configuration for errors.  The test button holds 
each registers assigned register number for easy testing.  Once the table is 
complete, check the Use RS232 radio button.  Next, press the Setup RS232 
button.  This displays a setup dialog for the RS232, shown in Figure 4.17. 
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Figure 4.17  RS232 Setup 
 
The appropriate COM port should be selected, together with the Baud rate.  
The Modus analog out device is now configured for use. 
 
Note:  RS-422 or RS-485 may also be used for longer distances.  The RS- 232 
to RS-422 or RS-485 converter is available through MIDAC. 
 
The capability exists for alarms on temperature of the cell, over pressure of 
the cell, high concentrations and temperature of any other device that gives 
input.  However, all inputs must be a 0 to +5V configuration with an 
isolated ground. Alarms may be configured to report over the modbus and 
trigger AQPro to respond in one of the following ways: 
 

1. Continue the analysis sequence and alarm until the condition no 
longer exists 

2. Stay on the current sample line and continuously sample 
3. Stop the sequence and switch to the purge manifold parameter 
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The purge manifold parameter is available through the valve module in the 
software where a hexadecimal bit set-up is entered to trigger a nitrogen 
flooding purge or some other assigned condition through the MIDAC 
control valve manifold. 
 
It should be noted however that only one of these alarm options may be 
chosen, and will apply to all alarms in the method. 
 
Analog inputs for the fiber optic distribution board may be configured using 
an interface available from MIDAC.  The interface will allow up to 14 inputs 
from other devices, on the condition that the inputs lie within the range 0 to 
+5 V (DC).  They must be ground isolated or serious problems may occur. 
 
A break-out board connection from the fiber optic distribution board is 
available from MIDAC that allows easy connection of any inputs. 
 

Figure 4.18  Analog In dialog 
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Parameters: Cells 
 

 
 
Figure 4.19  Parameters: Cells Display 
 
Enter the factory-supplied cell path length in the Pathlength field. 
 
Note:  Factory cell pathlength is determined based upon ambient 
temperature and pressure conditions unless specified otherwise in the factory 
literature.  Cell pathlength must be determined at the same temperature and 
pressure that your samples are to be collected.  Please determine your cell 
pathlength by following the instructions in Chapter 6. 
 
Make the appropriate T&P Controller selection from the drop down menu 
if a temperature/pressure sensors and controller are installed.  Use the Setup 
button to enter configuration information and test the device(s).  
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Temperature and Pressure Control:  Watlow Setup 
 
There are currently three options for temperature and pressure 
communication, None, Fiber Optics and Watlow.  Please determine which 
your system uses before continuing.  If your system is equipped with a 
peripheral control device (PCD), then it uses the Fiber option.  If the option 
Watlow is selected, pressing the setup button delivers the dialog shown in 
Figure 4.20. 
 

 
Figure 4.20  Watlow Temperaure / Pressure Setup  
 
The dialog has three tabs, Serial Port, Modbus settings and Test.  On the 
Serial Port tab select the appropriate Com port (usually Com 1) and set the 
baud rate to 19200.  The Modbus settings tab allows registers to be defined.  
The default settings will normally be used.  The pressure units shown on this 
tab should be set to psi.  The Test tab is used to check that temperature and 
pressure are read correctly.  If incorrect readings or errors result from 
pressing the Test button, refer to the Troubleshooting section of this 
manual. 
 
Temperature and Pressure Control:  Fiber Optic Setup 
 
If the user has purchased the peripheral control device (PCD) system from 
MIDAC, the Fiber option must be selected, the Setup button yields the 
dialog shown in Figure 4.21. 
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Figure 4.21  Fiber Optic Temperature / Pressure Setup 
 
The dialog box provides drop down menus selection of units, and a Test 
button allows readings to be checked.  Pressure units should be set to psi.  If 
incorrect readings result from pressing the Test button, refer to the 
Troubleshooting section of this manual.  The fiber optic controller will 
check for over / under temperature, pressure and flow parameters. 
 
In Figure 4.21, the units should be set accordingly.  There are 3 types of 
pressure transducers used; Voltage 0-30, Amperage 0-30, and Amperage 0-
50.  You can determine which transducer you have by reading the stamping 
on the side of the transducer.  Adjust the High pressure reading in the 
window accordingly to your transducer to obtain the correct pressure 
reading. 
 
The digital readout on the PCD has no bearing on the actual pressure input 
to the software as they are 2 separate channels.  You must determine that the 
correct pressure is being read into the software by clicking the Test button.  
Small changes to correct for actual barometric pressure under ambient 
conditions can be made at the setup screen by simply adjusting the High 
pressure value until the reading is correct under the Test… condition.  The 
digital readout on the PCD can then be adjusted to read what is actually 
being read into the software directly on the face controller by entering the 
set-up menu of the controller. 
 
The Update Every field specifies how often you want the system to take 
temperature and pressure readings.  Each time the specified interval elapses, 
the system will take fresh readings and record them with the other file 
information for each spectrum it collects.  All readings taken over the time 
interval of the acquisition of a spectrum are averaged and tagged to that 
spectrum.  For this reason more readings per sample are more representative 
of the actual conditions. 
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Note:  If you are performing a high speed or fast collection where time 
intervals are critical, the Update Every  field should be set to a longer time 
period.  Every time the software polls the temperature and pressure, some 
fraction of a second (depending on computer) is expended to write the info 
to the hard disk resulting in a slight change in time interval.  If time intervals 
must be exact, MIDAC recommends using the default feature or a longer 
update time. 
 
The Use Default Temperature and Use Default Pressure options allow 
you to enter the appropriate environmental conditions when temperature and 
pressure instrumentation are not installed or operational. 
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Parameters: Infrared Throughput 

 
Figure 4.22  Parameters: Infrared Throughput Display 
 
The Infrared Throughput setting on the Parameters menu lets you enable 
an alarm display if the system detects that the IR signal has fallen below the 
listed threshold values.  This can be a useful indicator that corrective action is 
needed (such as refilling a liquid nitrogen Dewar or cleaning optics) to avoid 
poor data quality during extended continuous monitoring runs. 
 
However, for a very high moisture matrix or high concentration matrix, the 
alarm may sound erroneously, since many of the photons are attenuated by 
the species in the matrix.  In this case, the IR throughput alarm should not 
be used. 
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Parameters: Numbers 

 
Figure 4.23  Parameters: Numbers Display 
 
The Numbers setting on the Parameters menu allows control of the format 
and precision in which various data are displayed and/or stored according to 
your preferences.  Options exist for displaying negative concentrations as 
zero and for displaying high resolution time information, which may be 
useful in reaction kinetics experiments. 
 
Parameters: Monitors 
 
The monitor’s dialog allows automated detection of currently configured 
monitors on the system. 
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4.24 Monitors Dialog 
 
 
 
Parameters:  Security 
 
The security tab on the parameters dialog allows the user to set a password, 
which will then be required to start or stop data acquisition, alter method 
parameters or to access a locked method.  The security dialog is shown in 
Figure 4.25 
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Figure 4.25 Security Dialog 
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Parameters: Test 
 

 
Figure 4.26  Parameters: Test Display 
 
The Test setting on the Parameters menu contains a variety of diagnostic 
settings that can be activated in consultation with MIDAC customer support 
personnel to help troubleshoot system or software malfunctions.  This screen 
should not be used for normal operation. 
 
The Connect, Setup, and Install Buttons 
The last three push buttons on the Instrument Screen, (Connect, Setup, 
and Install), are located under the Spectrome er field.  These buttons are 
used only for initial installation purposes and can be disregarded during 
routine operation.  Select the appropriate combination of 
computer/spectrometer interface card and ADC electronics for your system 
from the pull down list.  The DEMO instrument selection is provided for 
educational purposes only.  The Install button provides guidance for proper 
installation of instrument driver files.  The Setup button is related to the 
DEMO instrument mode, and can, therefore, be disregarded by most users.  
The Connect/Disconnect button is initially used to establish 
communication between the analyzer and computer. Once connected, there 
is seldom any reason to use the disconnect button.  Its primary purpose is to 
facilitate switching between different instruments. 

t
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The Spectral Display Buttons 

 
Figure 4.27:  Spectral Display Window Buttons 
 
Beneath the large spectral display window on the Ins rument screen is a row 
of graphic manipulation buttons.  These buttons let you select display 
formats to suit the task at hand and manipulate spectra displayed within the 
window.  If any function is not immediately obvious, position the cursor 
over a button and let it rest for a moment without clicking.  The description 
of that button’s function will appear.  

t

 

 
The two left-most spectral display buttons determine the format in which 
multiple spectra are displayed.  These buttons are only active on the View
Spectra screen that is used to simultaneously display the various reference 
spectra you have selected within a method.  Clicking on the Stacked (left) 
format button results in each successive spectrum being placed in its own 
“mini window” within the spectral display area; clicking on the Overlay 
(right) format button results in all selected spectra being superimposed.  Both 
are useful in observing the relative positions of key features in your reference 
spectra. 

 

 

 
The left-most button in the next group of five is used to Auto-scale the 
display along both X and Y axes.  This automatically applies the maximum 
level of horizontal and vertical expansion allowable while fitting all data in 
the window.  It is a one-step way to return from a highly magnified view to a 
full spectrum view.  You can get the same results by left-clicking the mouse 
with the cursor in the spectral window. 
 
Moving to the right, the Vertical Auto-scale button scales the Y axis to 
accommodate the largest feature within the currently displayed X axis 
boundaries, (the X axis scale remains unchanged).  This gives you the best 
possible view (maximum expansion while all inclusive) of all data within a 
selected wavenumber range. 
 
The Undo (U) and Redo (R) buttons step you backward and forward 
through the history of display manipulation.  Clicking Undo once takes you 
one step back, (undoes the last expansion, scroll etc.).  Subsequent clicks take 
you sequentially further back through recent operations.  Clicking Redo 
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takes you forward one step at a time until you reach the most recently 
performed display manipulation. 
 
Click on the Print button to print the current display window contents. 
 

 
The next four buttons Scroll the window contents to the left, right, up and 
down, respectively. Single click on a button to move a small increment.  Click 
and hold the mouse button down to scroll continuously until the desired 
region is displayed. 
 
To the right of the Scroll buttons are the Horizontal Contraction, 
Horizontal Expansion, Vertical Contraction and Vertical Expansion 
buttons.  Single click for incremental expansion or contraction with these 
buttons, click and hold for continuous action. 
 
Another way to quickly zoom in on exactly the spectral features you need to 
examine is to use the mouse directly in the spectral display window.  Position 
the cursor above and to the left of the area you want to zoom in on, hold 
down the left mouse button and drag downward and to the right.  This will 
form a temporary box around the area.  Click once inside the temporary box 
and its contents will be scaled to fill spectral display window. 
 

 
The last four spectral display buttons begin with the Information (i) button. 
Click this button to display the memo field, collection date and time, and a 
variety of other file information stored with the spectrum. 
 
To the right of the information button is a small field with a pull down list.  
As discussed in the Parameters: Storage section, multiple data formats can 
be saved during data collection (including absorbance, single beam and 
interferogram).  This field lets you select the format you want displayed from 
the list.  The list will change depending on what formats have been stored. 
 
The next button to the right allows users to Set Display Properties.  Click 
this button to enter maximum and minimum values for the X and Y axes, 
and to specify automatic or manual scaling in the spectral display window.  
These settings are made separately for each of the various data formats that 
can be displayed.  The entered X and Y axis values are not used when the 
AutoScale boxes are checked.  To use the entered values, uncheck the 
relevant AutoScale box(es), click the OK button, right-click the mouse on the 
spectral display window, then select Fixed Scale from the right-click menu.  
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The display window will then be scaled to your specified X and/or Y axis 
values.  You can then toggle between Auto Scale and Fixed Scale modes 
using the right-click menu. 
 
The second tab on the information entry box, Colors, lets you select 
different background colors for the spectral display window from a palette. 
 
The last button in the row is used to directly export the displayed data into 
Grams/32 software. Grams software must be installed on your computer for 
this Export function to operate. 
 
 
The Method Screen 
 

 
Figure 4.28  The Method Screen Display 
 
The method screen is accessed by clicking on the Method tab, and 
comprises three panes.  The uppermost of these is the Compounds pane.  
This section allows compounds to be defined.  The center pane is the 
Spectra pane, which facilitates the selection of reference spectra 
representative of each compound in the method.  The final pane is the 
Regions pane, which is the interface for the definition of spectral regions for 
analysis.  Regions are specified for each spectrum of each compound.  The 
Method screen is automatically displayed when you select any of the first 
group of Method Menu items or any of the Method Toolbar icons. 
 
Above the three panes of the Method Screen (namely, the Compounds, 
Spectra and Regions panes) are two push buttons and an information field. 
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The Calibrate button is used after you have defined the compounds, 
reference spectra, and spectral regions for inclusion in your method.  During 
calibration, AutoQuant Pro© performs two operations: 
 
1. It generates sub-methods 
2. It calculates prediction matrices 
 
A sub-method consists of one reference spectrum for each compound used 
to calculate a prediction matrix.  In a full calibration, a sub-method is created 
for each possible combination of reference spectra for every compound.  
Therefore, the number of sub-methods generated by a given method is 
determined by multiplying the number of spectra in each compound, and 
then multiplying by the total number of compounds in the method.  For 
example, a method in which compound #1 has three reference spectra, 
compound #2 has two reference spectra, and compound #3 has one 
reference spectrum will generate a total of 3 x 2 x 1 x 3 = 18 sub-methods.   
 
The number of possible sub-methods increases exponentially with additional 
reference spectra and/or compounds.  However, the more reference spectra 
used in the method, the better the accuracy and precision of the reported 
results. 
 
The Parameters button is identical to the Parameters button on the 
Instrument Screen.  Please refer to the descriptions provided in the 
Instrument Screen section for a full explanation of options for all menu 
items under the Parameters button. 
 
The information field to the right of the Parameters button identifies the 
currently active method.  A brief summary of key settings defined for this 
method also appears to the right of the Information field. 
 
A right mouse click in any of the three panes will display an appropriate 
menu for actions appropriate to the area in which the mouse is clicked.  
These menus are described below.  Note, a right mouse click on the pane 
background provides an abbreviated menu to add a compound, spectrum or 
region, or to view a spectrum.  A right mouse click on an item already 
defined in the table provides a menu with many more options. 
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The Compound Pane 

 
Figure 4.29  Right-Click Compound Table Menu (brief) 
 
Figure 4.29 shows the brief menu displayed when you right click on the 
background area of the Compound Table.  The only item on this menu is 
New Compound.  Select this item when you want to add to the list of 
defined compounds.  A small box for entry of the name, description, 
molecular weight is provided.  An option to input a Computed Compound 
is also provided.   
 
Computed Compounds 
 
A computed compound is sometimes referred to as a ‘virtual’ compound, as 
opposed to a ‘real’ compound.  A ‘real’ compound is one which has spectra 
associated with it.  A computed compound has no spectra associated with it; 
the results for a computed compound are derived from those of real 
compounds and/or sensors or inputs and a user-defined equation.  This 
allows the user to combine results from real compounds to produce results 
for a virtual compound (such as NOx), or to include calculated results such as 
mass flow in the output or to correct to dry concentrations, a predesignated 
O2 level, or CO2 concentration, or all three.  The results for a computed 
compound are treated as results for actual compounds by AutoQuant Pro©, 
so that computed compounds appear in the results table, may be used in 
alarms and can be reported over modbus or analog out. 
 
When a new computed compound is added to a method, (either using the 
Right Click menu for the Compound pane or using the Method menu) the 
dialog shown in Figure 4.30 appears. 
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Figure 4.30  The Computed Compound Dialog 
 
It is necessary to assign a name, units, and equations for the computed 
compound. 
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The computed compound equation 
 
Consider a method with three ‘real’ compounds named  C1, C2 and C3. 
 
Available ‘variables’ 
C1 The calculated concentration for compound C1. 
C2 The calculated concentration for compound C2. 
C3 The calculated concentration for compound C3. 
C1_SEC The calculated uncertainty (SEC) for compound C1. 
C2_SEC The calculated uncertainty (SEC) for compound C2. 
C3_SEC The calculated uncertainty (SEC) for compound C3. 
C1_MW The molecular weight of compound C1, as defined in the 

method setup. 
C2_MW The molecular weight of compound C2, as defined in the 

method setup. 
C3_MW The molecular weight of compound C3, as defined in the 

method setup. 
C1_integral The integrated area of C1’s analysis region(s) for the 

current sample. 
C2_integral The integrated area of C2’s analysis region(s) for the 

current sample. 
C3_integral The integrated area of C3’s analysis region(s) for the 

current sample. 
C1_integralBLC Baseline corrected integrated area of C1’s analysis 

region(s) for the current sample 
C2_integralBLC Baseline corrected integrated area of C2’s analysis 

region(s) for the current sample 
C3_integralBLC Baseline corrected integrated area of C3’s analysis 

region(s) for the current sample 
Timestamp The timestamp of the current sample minus the time the 

timestamp of the start of the current measurement, 
representing the time elapsed in milliseconds for the 
current collection. 

sampleNumber The number of the current sample since AQ Pro was 
started.  The first sample is sample 1. 

temperature In degrees C, from the sensor or a default value. 
pressure In atmospheres, from the sensor or a default value. 
flowrate In cubic feet / minute, from the sensor or a default value. 
pathlength In meters, from the defined value for the active cell. 
Timestamp The timestamp of the current sample minus the timestamp 

of the start of the data measurement. It represents elapsed 
time in milliseconds for 
the current collection. 
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Analog Inputs Any name from the analog inputs table 
throughput Returns “1” if the throughput test is passed, “0” if failed. 
sampleNumber The sample number of the current sample since AQPro 

was started.  The first sample is sample 1. 
 

 
Data file timestamps are expressed as milliseconds since midnight (00:00:00) 
January 1st 1970, coordinated universal time.  The timestamp reported here is 
the data file timestamp minus the timestamp of the start of the measurement 
at the time the Start button was pressed in AutoQuant Pro©.  It represents 
elapsed time in milliseconds since the start of the measurement.    These can 
represent time until 19:14:07, January 18th 2038.   The sampleNumber is 
meant to be used in conjunction with an external watchdog program that 
monitors Modbus output.  If for any reason the sample number does not 
increment, the watchdog program can flag a problem.  User-defined inputs 
(up to 16) can be assigned to any fiber optic input register. These user-
defined names will be available for use in the equation. For instance, an 
oximeter detector may be available, in which case the user may define it is 
‘percentO2’. Then ‘percentO2’ will be available as a variable for computed 
compounds. 
 
Math Operators 
* Multiply 
/ Divide 
% Modulo: 10 % 3 = 1 : remainder  
^ Power (x^y) 
+ Addition 
- Subtraction (or unary negation) 
(  and ) Precedence: define the order of evaluation 
 
 
Normal arithmetic precedence applies to equation evaluation. When in 
doubt, use ‘(‘ and ‘)’ to make the order of evaluation explicit. 
 
 
Available Constants 
pi 3.14159265358979323846 
e 2.71828182845904523536 
 
Available Functions 
log Log base 10 
ln Natural log 
sqrt Square Root 
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sqr Square 
sin Sine 
cos Cosine 
tan Tangent 
asin Arc Sine 
acos Arc Cosine 
atan Arc Tangent 
abs Absolute value: abs(-2) = 2 
neg Negate: neg(2) = -2 
exp Exponentiation: exp( 2.302585 ) = 10.0 
pow Power: pow(2,3) = 8 
frac Calculates the fractional part of a number: 

frac(1.2) =0 .2 
mod Calculates the floating-point remainder f of x /y 

such that x =i * y + f, where i is an integer, f has 
the same sign as x, and the absolute value of f is 
less than the absolute value of y: mod(- 
10, 3) = -1 

PeakAt(wavenumber1, 
wavenumber2) 

Returns the maximum absorbance value found 
between wavenumber1 and wavenumber2 for 
the current sample. See notes below. 

ValueAt(wavenumber) Returns the absorbance value at the given 
wavenumber for the current sample. See notes 
below. 

Integrate(wavenumber1, 
wavenumber 2) 

Returns the integrated area over the region 
defined by wavenumber1 and wavenumber2 for 
the current sample. See notes below. 
 

Integrate2(wavenumber1, 
Wavenumber2) 

Like the above, with extra ‘method’ parameter. If 
method is 0, the integral is calculated to a 
baseline of 0. If method is 1, a linear baseline 
between wavenumber1 and wavenumber2 is 
subtracted before the integral is taken. 
Integrate2(wavenumber1, wavenumber2, 0) is 
equivalent to the above integrate(wavenumber1, 
wavenumber2) function. 
 

throughput Returns a value according to the results or a 
throughput test, 1 for a pass and 0 for a fail.  
These values in common with other computed 
compound outputs may be linked to an alarm. 
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The functions PeakAt, ValueAt and Integrate use a baseline corrected 
version of the current sample unless it is a single beam spectrum. The 
baseline correction order is determined by the method’s baseline correction 
order on the method setup dialog. For the computed compound calculator, 
the baseline order of 3 (quadratic) is not used. For second order (linear) 
baseline correction it uses a DRIFTS method. The baseline corrected spectra 
can optionally be written to disk for testing purposes by turning on the 
checkbox labeled ‘Save Computed Compound BLC data’ on the 
Tools/Parameters/Test dialog. The BLC’d data will be written into the same 
directory as the sample, with the same filename as the sample except that 
‘_blc’ is appended to the root filename. If the sample is a single beam, the 
data is first inverted and then offset back to zero (the data is multiplied by –
1, then the minimum value is found and subtracted from each point), but it is 
not baseline corrected. Integration uses the composite Simpson rule, which 
needs at least 4 datapoints in the given region. 
 
 
Example Equations for a Computed Compound 
2*C1 + 3*C2 + 4*C3 Weighted sum of individual concentrations. 
C1 / C2 * 100 C1 as a percent of C2. 
C1_SEC / C1 Ratio of uncertainty to concentration. 
C1 * C1_MW * 
flowrate 

Basis of ‘mass emissions’ calculations. 

temperature Will simply report the temperature in a column of 
the results table.  Associate with an alarm to signal 
over-temperature conditions. 

1 A constant: the number 1. Useful as a placeholder 
for undefined uncertainty calculations. 

 
Reserved Names 
 
This affects the name that you give a compound.  Some words are reserved 
and cannot be used for the names of real or computed compounds in the 
method.  Compound names cannot end in ‘_MW’ or ‘_SEC’.  Compound 
names cannot be the same as any of the function names (log, ln, etc).  
Compounds cannot be named ‘temperature’, ‘pressure’, ‘flowrate’, or 
‘pathlength’.  
 
Names are evaluated without case sensitivity: ‘Flowrate’ matches ‘flowrate’.  
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Other Restrictions 
 
In future releases, users will be able to define arbitrary values that are input 
via the fiber optic registers. The user-assigned names will not be allowed to 
collide with compound names, built-in function names, etc. 
 
Computed compounds cannot be used in the calculation of other computed 
compounds because this could create circular references and evaluation order 
dependencies. 
 
 
The uncertainty equation 
 
Forming a correct uncertainty equation for a given computed compound 
involves the evaluation of partial derivatives. It’s beyond the scope of a 
program like AQPro to automatically determine the uncertainty equation for 
any given computed compound equation. The user has to provide a correct 
equation for the uncertainty of a computed compound. 
 
For example, assume a computed compound equation that is the simple ratio 
of two quantities: C1/C2. The uncertainty equation is: 
 
    sqrt(sqr(1/C2_SEC)+sqr(-1*C1_SEC/(C2_SEC*C2_SEC))).  
 
That is, it’s the square root of the sums of the squares of the partial 
derivatives of the individual component uncertainties. The individual 
component uncertainties are the partial derivatives of C1_SEC/C2_SEC, 
which are (1/C2_SEC) with respect to C1_SEC and (-1 * C1_SEC / 
C1_SEC * C2_SEC) with respect to C2_SEC. 
 
In many cases the uncertainty associated with a computed compound is of 
little or no importance.  In these cases a constant may be used as the 
computed compound uncertainty equation.  This constant may take the value 
zero. 
 
Compounds 
 
Three compounds are defined (CO2, acetone and ethanol) in the method 
depicted in Figure 4.25.  The first column in the table, Incl, indicates which 
compounds are currently included in the method.  You can include or 
exclude any of the defined compounds to suit your needs during method 
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development or for actual analysis.  Excluding extraneous compounds can 
greatly reduce computation time and disk space as the system determines the 
need for and builds calibration matrices to perform an analysis.  Excluding 
extraneous compounds can also improve the accuracy of the concentrations 
of other compounds because every time a compound is subtracted whether it 
is present or not, some additional noise is added to the resulting subtraction 
spectrum 
 
Clicking on the second column, Edit, lets you enter a description and 
molecular weight for the compound as shown in Figure 4.31. 
 

 
Figure 4.31  Compound Properties Edit Window 
 
In Figure 4.31, the molecular weight can be added to compute mass 
emissions in mass/time.  Additionally, the box labeled report 0 ppm if the 
ratio of the SEC to PPM is greater than X can be checked to prevent any 
false positive results for a compound.  A false positive is a concentration that 
is reported for a compound that is not really present in the sample.  AQPro 
will attempt to calculate a concentration based upon the spectral area(s) 
chosen for quantification.  Although the compound absorbance bands may 
not be present, any noise of interfering compounds may exhibit a reported 
concentration.  However, the standard error calculation (SEC) is also 
reported with the concentration indicating how well the target compound fit 
the reference spectra.  The SEC represents 1 standard deviation or a 68% CI.  
Multiplying the SEC by 2 results in a 95% CI and by 3 a 99% CI.  If the SEC 
number is high, it is up to the user to determine if the target compound is 
truly present.  This can be achieved by examining the residual spectrum.  If 
the SEC is high, the reported result may be a false positive.  By setting the 
ratio in this box to a predetermined concentration, false positives can be 
averted.  Typically if the SEC is ½ the reported concentration or higher, then 
the result is suspect.  By typing in 0.5 in the ratio field, any SEC results that 
are greater than ½ the reported concentration will be automatically reported 
as zero.  The SEC can be reduced by adding in a interfering species to the 
method that allows the software to subtract out the interference. 
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The last two columns on the right in Figure 4.26 contain the compound 
name and description fields.  MW is used only for mass emission reporting 
where flow rate is recorded through an external device or the default is used.  
The dialog may also be used to enter a threshold for the ratio of 
concentration to SEC.  This enables the software to distinguish between 
legitimate low concentrations and baseline noise.   
 
Items in the Compound Table, as well as the Spectra and Regions Tables can 
be sorted according to the information in several of the columns.  To sort by 
a column, place the cursor on the column heading and click.  To reverse the 
order of the sort, click again.  An indicator in the column head points upward 
or downward for ascending or descending order. 
 

 
Figure 4.32  Right-Click Compound Table Menu (full) 
 
Figure 4.32 shows the more extensive right click menu provided when the 
cursor is positioned on a defined compound. Note that all three tables on the 
Method Screen are linked - when you click on a defined compound the 
reference spectra defined for that compound will appear in the Spectra pane, 
and the regions that have been selected for analysis for those spectra will 
appear in the Regions pane. 
 
The first two items on the menu, Edit and Add Compound, are explained 
in preceding paragraphs. 
 
The Add Spectrum item lets you: select an individual spectrum stored on 
disk, select a spectrum from a library collection stored on disk, use the last 
spectrum collected on the instrument or run a new data collection to create 
the spectrum. When you choose to add a stored spectrum from disk or 
library, a browser window opens, as shown in Figure 4.33.  
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Figure 4.33  Add Spectrum Window 
 
Several features are provided to help you locate exactly the file you are 
seeking as you browse through spectra stored on disk.  When you select a 
potential candidate, (highlighting with a single mouse click), the spectrum 
appears in the lower display window with all graphic manipulation buttons 
available for use.  The file’s location and memo field information are 
displayed below the spectrum.  Click on the Memo Fields button to view 
descriptive information for every spectrum stored in the current directory.  
 
If you select From Instrument on the Add Spectrum menu, your choices 
are to use the last spectrum acquired by the instrument, or to immediately 
initiate collection of a new spectrum by choosing Acquire New.  The 
spectrum will be acquired using the currently specified instrument 
parameters.  Make sure these settings are compatible with all stored 
references you are using. 
 
The next item on the full right click menu is Add Alarms.  Alarms allow you 
to trap conditions when the concentration of a given compound or input 
exceeds or falls below threshold levels.  For example, continuous monitoring 
applications may opt not to store spectral data as long as concentrations 
remain within acceptable ranges.  If the Save Abs. On Alarm option on the 
Parameters: Storage menu is activated, the system will immediately begin 
storing data for archival or post event analysis purposes when an alarm 
condition occurs.  AutoQuant Pro© will notify the user by displaying a 
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message and sounding an audible alarm.  The software also turns on bit 6 
of the spectrometer AUX port when any alarm condition arises. 
 
You can designate up to four alarm conditions, (red high, yellow high, yellow 
low and/or red low), for each compound.  The Add Alarms screen allows 
specification of which alarm conditions you want to activate and the 
concentration threshold assigned to each alarm.  
 

 
Figure 4.34  Alarm Setup Window 

 

The Field Point button may be used to set up the alarms over a field point 
output.  This option is discussed in the section on field point setup. 
 
 
The next item on the full right click menu is Add Output.  This feature allows 
communication of concentration levels for a given compound to an external 
input device.  It is fully described in the Parameters: Analog Out section of 
this manual. Note: the analog output device must be selected in the 
Parameters menu before the Add Output menu item can be used. 
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Figure 4.35:  View Spectra Window 
 
The next item on the full right click menu is View Spectra.  This feature 
allows you to display any or all of the reference spectra already assigned to 
compounds defined in your method.  You can choose to overlay the various 
spectra, or view them in “stacked” format as shown in Figure 4.35.  The 
grayed sections of the display indicate which regions of each spectrum have 
been selected for inclusion in concentration calculations. This “selected 
region” feature can be toggled on and off with the Show Regions check box 
at the top of the window.  A Full Screen push button in the upper right-
hand corner of the window lets you toggle between the large, full screen view 
and smaller window format.  Clicking on individual file names on the list to 
the left alternately includes and excludes spectra from the display (as 
indicated by the check boxes beside the file names). 
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Figure 4.36  View Linearity Window 
 
The last items on the full right click menu are View Linearity, Delete and 
Cancel.  Use Delete to remove the highlighted compound and its associated 
reference spectra from the method.  Use Cancel to exit the menu. 
 
The View Linearity window presents a graphic display of the predicted 
concentrations, (based on the model produced by the currently defined 
method), versus actual concentrations of reference spectra.  This display is 
useful in determining the degree to which reference spectra for a given 
compound exhibit linearity over the range of concentrations you have 
chosen.  If, in fact, the compound is highly linear, you may be able to save 
the extra computation time and disk space required by a non-linear method, 
or you may be able to reduce the number of reference spectra used in 
concentration calculations.  A highly non-linear curve (i.e. one in which the 
gradient at the high end is close to zero) is a good indicator that the regions 
chosen for analysis are too highly absorbing to conform to Beer’s law, and 
different regions should be selected. 
 
Outlier Detection and FCU Display  
 

                                                    68 

There are two choices for displaying how closely your prediction model 
matches up to actual concentrations.  Outlier Detection can be displayed as 
either First or Second Order Polynomials.  These polynomials are for 
illustrative purposes only, and in no way reflect the actual quantification 
algorithm.  The FCU Display is the Fractional Calibration Uncertainty and 
represents data as the % error of each data point from the linear model.  This 
feature allows the user to determine two things:  



 
1) Is the compound linear for the regions and concentrations 

chosen for quantification? 
2) Are there any data points that do not fall along a predictive curve, 

and so can be considered outliers? 
 
The pushbuttons on this display are fairly self-explanatory – allowing you to 
print or export the chart or table for use outside AutoQuant Pro©. 
 
The table at the bottom of the window displays the calculated values for data 
points in the plots above. 
 

 
Figure 4.37  Right-Click Spectra Table Menu (full) 
 
A right mouse click on the Spectra Table background brings up the brief 
menu version with three choices: Add Spectrum, View Spectra, and 
Cancel.  A right mouse click on a reference spectrum within the Table 
displays the full menu shown in Figure 4.37.  
 
The Add Spectrum, View Spectra, and View Linearity items are described 
in the preceding Compound Table menu discussion. 
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Figure 4.38 The Edit Reference Window 
 
The first menu item, Edit, opens the window shown in Fig. 4.38.  You may 
enter or revise Temperature, Pressure, Pathlength, or Concentration 
information in this window.  The first three of these values can be applied 
either to the highlighted spectrum alone or across all reference spectra for 
one or more compounds in the method.  Of course, global editing of 
reference information should be used with care.  The Primary Spectrum 
check box near the bottom of the window can only be used for one reference 
spectrum per compound.  A linear method uses only the primary spectrum 
from each compound to build the matrices used for concentration 
calculations, even when multiple references have been defined for one or 
more compounds.  Therefore, you should designate the reference spectrum 
of highest concentration that represents the most commonly encountered 
sample conditions as your Primary Spectrum.   
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Figure 4.39  The Add Region Window 
 
The Add Region window provides several features for selecting the exact 
spectral regions for use in concentration calculations.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                    71 



The Analyze Screen 
 

 
Figure 4.40          The Analyze Screen Display 
 
The Analyze screen is accessed by clicking on the analyze tab.  The screen 
comprises three main sections.  The uppermost of these is a strip chart.  This 
chart graphs the concentration of compounds in the method against time.  
This chart is generated either as part of a real time analysis or whenever data 
is re-batched.  The bottom left of the Analyze screen houses a results table.  
This table has two tabs, All and Current.  The All tab displays results and 
standard error calculations (SEC) for each time point of the analysis.  The 
Current tab displays results for the current time point only.  At the bottom 
right of the Analyze screen is a spectral display window.  This display shows 
the most recently acquired spectrum of the current analysis.  The spectral 
display is actively linked to the results table and the concentration strip chart.  
Clicking on either a concentration from the results table or a data point on 
the strip chart results in the associated spectrum being displayed in the 
spectral display section.  Functions present on the side toolbar are also 
duplicated on the Analyze screen via radio buttons.  This provides a number 
of ways of accessing the data acquisition modes Batch, Single, Continuous, 
High Speed and Automatic.  Also present are four pushbuttons.  These are 
Start, Stop, Resume Current and Resume Previous.  The Start button 
initiates analysis in the selected mode.  Stop ends the analysis.  Resume 
Current picks up the analysis that was most recently stopped, without 
changing data subdirectories, while Resume Previous resets the analysis to 

                                                    72 



the previous mode and preferences.  We will now treat each of the three 
sections of the Analyze screen in detail. 
 
The Concentration Strip Chart 
 
The strip chart is illustrated in Figure 4.41. 
 

 
 
Figure 4.41  The Concentration Strip Chart 
 
The chart plots the output of the analysis against time.  The view can be 
manipulated using the graphic control buttons located on the top left of the 
chart area.  Also included on this toolbar are options to set the chart 
properties, print the chart and to copy the chart to the clipboard as a 
Windows Metafile.  Metafiles may be pasted directly into word processing, 
powerpoint, or spreadsheet document.  Pressing the strip chart properties 
button delivers the dialog shown in Figure 4.42. 
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Figure 4.42  The Strip Chart Properties Dialog 
 
The dialog may also be accessed by right clicking in the strip chart area.  A 
drop down menu allows selection of time units for the x-axis.  A similar 
menu for the y-axis allows selection of either ppm or ppb as concentration 
units.  The radio buttons Show all Samples and Show Last: specify 
whether the whole of the analysis is plotted or, in the case of extremely long 
analyses, a portion of the results may be displayed.  The time points to be 
displayed in the latter option are defined using the text box and the drop 
down menu beside the radio button.  Similarly, the scale of the y-axis may be 
defined by selecting either Autoscale or Fixed Scale.  The scale is specified 
by entering the appropriate minimum and maximum y-values into the text 
boxes provided.  The data points may be included or excluded from the 
output using the Show Data Points check box.  A grid may be displayed on 
the chart or removed using the Show Grid check box.  A drop down menu 
allows selection of the chart background color.  The compounds used in the 
analytical method are displayed on the left of the lower window of the dialog.  
In the center of this window are a series of check boxes that allow selection 
or de-selection of each compound to be displayed.  The color assigned to 
each compound in the display may be specified by clicking on the color 
associated with the compound.  This action returns a palette, from which an 
appropriate color may be chosen.  
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The Analysis Results Monitor 
 
While the analysis is in progress, results may be monitored using the results 
table section of the Analyze screen.  This table is shown in Figure 4.43. 
 

  
 
Figure 4.43  The Results Monitoring Table 
 
 
The table has two tabs.  Current shows the results from the most recent 
spectrum, while All displays results from the whole analysis.  These results 
are for monitoring purposes only, and do not have the output functions of 
the Results screen.  If “display negative numbers as 0” is checked under 
Parameters – Numbers, then any zero in red is really a negative number.  
Negative numbers are statistical numbers. 
 
 
The Spectral Display Area 
 
The third area of the Results screen is the spectral display area.  As an 
analysis progresses, the most recently acquired spectrum is displayed in the 
window.  An example is shown in Figure 4.44.  
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Figure 4.44  The Spectral Display Area 
 
Parameters associated with the acquisition of the spectrum currently 
displayed are listed in the window.  The display may be manipulated as 
normal, using either the graphic control buttons above the spectrum or using 
a mouse to select and expand areas.  The display is dynamically linked to the 
results and strip chart areas of the Analyze screen, making it possible to view 
a particular spectrum simply by selecting a result or time point.  A spectrum 
displayed in this window is available to Grams via the Send To Grams 
button, on the extreme right of the toolbar. 
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The Results Screen 
 
The Results screen is the section of AutoQuant Pro© that summarizes the 
results of a complete analysis.  The screen is shown in Figure 4.45. 
 

 
Figure 4.45  The Results Screen 
 
 
The Results screen is accessed by clicking the Results tab.  The major 
feature of this screen is a results table, which resembles a spreadsheet.  Four 
push buttons are located on the top left of the screen.  These are Clear All, 
Clear Current, Export and New Table.  A drop down menu labeled 
Sample Lines completes the list of functions applicable to this screen   An 
example of results output is illustrated in Figure 4.46. 
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Figure 4.46  Results Table 
 
The results for a specific time point may be read across a row.  The first 
entry in a row is a time and date stamp, which is attached to a spectrum upon 
acquisition.  The second entry is the method name.  The third entry is the 
filename of the spectrum.  The forth entry details the sample line from which 
the sample was introduced (if only one sample line is used N/A is displayed).  
Entries subsequent to this alternate between concentrations for each 
compound in the method and their associated standard error calculation 
(SEC).  This SEC represents a 1σ standard uncertainty, and so 2 × SEC is 
approximately equal to a 95% confidence interval.  The Columns may be 
expanded or collapsed in the same way as spreadsheet columns.  Copy and 
printing options may be accessed via the Right Click menu.  If a new 
analysis is started a new table will be inserted into the Results screen. It is 
possible to switch between the results tables using the tabs at the bottom of 
the table.  Each table may be renamed by right-clicking on the tab and typing 
the new name.  Clicking the Clear All  button deletes all tables in the 
Results screen.  Clicking the Clear Current button clears only the table 
currently on display.  The Export button has two options.  These are 
displayed by clicking on the chevron just to the right of the button.  This 
displays a check toggle, from which either To Clipboard or To Excel may 
be selected.  The To Clipboard option copies the current table to the 
clipboard, making the data available to any program that accepts pasted data.  
The To Excel option allows direct transfer to Microsoft Excel, assuming the 
program is installed. Once the desired option has been chosen, clicking 
Export will complete the operation.   It is also possible to send the results to 
a CSV (comma-separated value) disk file. 
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Clicking the New Table button inserts a new table into the screen.  The 
table will be titled Run x where x is the number of the run.  If multiple 
sample lines are in use, data from specified lines may be accessed by selecting 
the desired line from the drop down menu Sample Lines. 
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Chapter 5 
Menus and Toolbars 
 
The File Menu 
 
In this chapter we will treat in depth the menu items and toolbars first 
encountered in Chapter 3.  Menu items often have associated ‘Hot Keys’.  
These short cuts are listed to the right of the menu items when available.  
The first menu to be detailed is the File menu, illustrated in Figure 5.1.   
 

 
Figure 5.1 The File Menu 
 
The menu items will be treated sequentially.   
 
New Method 
 
The New Method item generates a blank method, and displays a dialog box 
which is used to input information on the new method.  The New Method 
dialog is shown in Figure 5.2. 
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Figure 5.2  New Method Dialog Box 
The directory in which the new method will be filed is displayed in the grayed 
out text box.  This directory may be changed using the Browse button.  The 
default when using Windows 2000 professional is C:\Documents and 
Settings\All Users.WINNT\Documents\AutoQuant4\Methods.  The 
default directory for methods can be changed using the 
Tools/Parameters/Paths dialog  
  
Three other text boxes are displayed.  Two of these are used to enter names 
for the method subdirectory and the file name for spectra acquired under the 
method.  The final text box in the dialog is used to enter a description of the 
method, which may be useful for future reference. 
 
Open Method 
 
The Open Method menu item is used to select and open a previously 
generated method.  A dialog box opens to display a list of methods 
previously assembled by the user in the default directory.  This dialog is 
shown in Figure 5.3 Other directories may be accessed using a drop down 
menu. 
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Figure 5.3  Open Method Dialog Box 
 
 
Only methods with the file extension .AQ4 may be opened in this way.  The 
subdirectories listed in the dialog may be double clicked to display the AQ4 
method file. 
 
 
Reload Method 
 
This menu item reloads a copy of the current method.  This is useful if you 
have made changes to the method that you want to discard and return to the 
last saved version of the method. 
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View Previous Results 
 
This menu item allows loading of a set of previous results into the current method.  The results are 
loaded as a file with the extension .aqr from the dialog box shown in Figure 5.4. 
 

  
 
Figure 5.4  Previous Results Dialog Box 
 
As with the Open Method dialog a set of results may be located using a drop down menu. 
 
 
 
Import AQ3 Method 
 
For reasons of back compatibility AutoQuant Pro© includes a utility for importing AutoQuant 3 
method files.  This menu item works in an analogous manner to the Open Method function, the 
difference being that only files with the extension .me can be loaded in this way.   Please check all 
parameters after importing an AutoQuant 3 method for errors. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



Method Map 
 
This menu item is used to provide detailed information on the currently loaded method.  The Method 
Map window is illustrated in Figure 5.5. 
 

 
 
Figure 5.5  Method Map 
 
All information associated with a method is detailed in the map.  This information represents 
everything needed to reproduce a method should the original be lost for any reason.  The map may be 
copied to a clipboard or printed directly using the push buttons at the bottom of the map window.  
 
 
 
Save Method 
 
This menu item saves the currently loaded method to its directory with a single click.  A method must 
be saved before closing after modification or all changes will be lost.  The save as button may be used if 
you would like to save the changes under a different name, avoiding overwriting a previous method.  
 
 
 

 



 
 
Save Method As 
 
The Save Method As menu item allows the user to save the current method to a different directory 
with a new subdirectory and filename.  The Save Method As dialog is shown in Figure 5.6. 
 

 
 
Figure 5.6  The Save Method As Dialog Box 
 
The directory must be changed to prevent the method file being overwritten.  This is achieved using the 
browse button.  If the create button is pressed without changing the destination directory a warning 
notice will be displayed, and the method will not be saved.  If the method is ‘saved as’, the ‘saved as’ 
method is now the current method 
 
Print and Print Setup 
 
The AutoQuant Pro© screen may be printed using the Print and Print Setup menu items.  This item is 
context sensitive.  For example, when in Instrument view a spectral plot will be printed, when in 
Results view a results table will be printed. 
 
At the bottom of the File menu a list of recently loaded method files appears.  This list allows 
convenient loading of these files by left clicking on the desired method.  
 
 
 

 



 
 
 
 
 
The Instrument Menu 
 
The Instrument menu is shown in Figure 5.7. 
 

   
 
Figure 5.7  The Instrument Menu 
 
The menu items Align, Sample, Background and Stop duplicate the functions of the buttons with 
the same name.  These functions are described in detail in Chapter 4.  The remaining menu items are: 
 
Load Disk Background 
 
The menu item Load Disk Background allows a previously acquired background spectrum to be used 
in the creation of absorbance spectra in the current method.  The Load Disk Background dialog is 
shown in Figure 5.8. 
 

 



 
 
Figure 5.8  Load Disk Background Dialog Box 
 
Background spectra are stored with the file extension .rsb, as opposed to the extension .abs applied to 
sample spectra.  The extension .rif designates a background interferogram.  A browser window 
occupies the upper portion of the dialog.  From this window it is possible to navigate through all 
available drives in order to locate a desired background spectrum.  A drop down menu below the 
browser labeled Libraries may be used to browse folders specified to AutoQuant Pro© as libraries.  
The topic of creating and managing libraries will be covered in detail later in this section.  The lower 
portion of the dialog is taken up with a spectral display, with options for displaying and editing 
associated information. 
 
 
 
View Background 
 
The View Background menu item is used to display, save and collect   background spectra.  Memo 
information associated with the background is also available for editing.  The View Background dialog 
is shown in Figure 5.9. 
 

 



 
 
Figure 5.9  View Background Dialog Box 
 
The Load from Disk button displays the Load Disk Background dialog box illustrated earlier in Figure 
5.8.  The Save to Disk button allows the background spectrum currently displayed to be saved to an 
available drive.  The Collect from Instrument button begins acquisition of a new background 
spectrum, using the parameters defined in the method for background collection.  Once acquisition is 
complete, the new background is displayed in the window.  Information associated with the 
background spectrum may be edited using the Edit Memo button. 
 
Sample 
 
The Sample menu item may be used to initiate collection of a sample spectrum.  This item duplicates 
the function of the Sample button, discussed in Chapter 4. 
 
Scan Parameters 
 
The Scan Parameters menu item displays the Parameters dialog box, shown in Figure 4.5.  From this 
dialog all parameters related to acquisition of data may be set, as discussed in chapter 4. 
 
Stop All Jobs   
 
The Stop All Jobs menu item is one of a number of options that may be used to terminate data 
collection.  This function is identical to the Stop button on the align and method screen, as well as the 
red Stop sign displayed in the upper left corner of the AutoQuant Pro© desktop. 

 



 
Add to Method 
 
The Add to Method menu item is used to include a new sample spectrum in a method. 
 
 
Predict 
 
The Predict menu item is not implemented at this time. 
 
 
 
The Method Menu 
 
The Method menu is illustrated in Figure 5.10. 
 

 
Figure 5.10  The Method Menu 
 
Add Compound 
 
The Add Compound menu item is used to specify analyte compounds for inclusion in the method.  
The Add Compound Dialog is shown in Figure 5.11. 
 

  

 



 
Figure 5.11  Add Compound Dialog Box 
 
The name of the compound is entered in the top text box.  If the user intends to add a computed 
compound to the method (see Chapter 4 for definition) the compound name must be treated as one 
word, for example Nitric Oxide becomes Nitric_Oxide.  This is necessary in order for the computed
compound function to evaluate the compound name as a variable.  The molecular formula for the 
compound is usually entered as a description.  The molecular weight is entered only so that mass flow 
calculations may be performed when reading in flow rates or velocities from an external device.  There 
are two check boxes.  The first of these allows the user to specify whether to display results for this 
compound.  The second check box allows spurious concentrations to be eliminated.  If a target 
compound is not present in a matrix, AutoQuant Pro© may try to interpret noise as a signal.  Setting an 
appropriate threshold ratio between concentration and SEC distinguishes between real and false results. 

 

 
Add Computed Compound 
 
The Add Computed Compound menu item allows the user to combine results from real compounds 
in order to produce a required result for output.  The Term Computed Compound is more fully 
defined in Chapter 4, together with a list of operators and functions that may be used.  The Computed 
Compound dialog is shown in Figure 4.27. 
 
Add Spectrum 
 
The Add Spectrum menu item is used to specify reference spectra for quantification of a compound.  
This function is discussed in Chapter 4, and the Add Spectrum dialog is illustrated in Figure 4.29. 
 
 
Add Region 
 
The Add Region menu item is used to specify regions for analysis for each compound.  The Add 
Region dialog box is shown in Figure 4.35, and the feature is fully detailed in Chapter 4. 
 
Add Alarm 
 
The Add Alarm menu item allows the user to set alarms for compounds with concentrations which 
exceed or fall below specified tolerances.  The Add Alarm feature is discussed in Chapter 4, and the 
Add Alarm dialog is shown in Figure 4.30. 
 
Add Output 
 
The Add Output menu item is used to configure analog output of results from AutoQuant Pro©.  
Currently supported outputs are field point and modbus.  Instructions for configuring these outputs are 
detailed in Chapter 4. 
 

 



 
 
 
Method Map 
 
The Method Map menu item displays a printable record of all parameters associated with a method.  
The Method Map is discussed in the File menu section of this chapter, and an example is shown in 
Figure 5.5.   
 
View Spectra 
 
The View Spectra menu item allows the user to view all spectra used in a method.  The View Spectra 
window is shown in Figure 4.31, and the feature is discussed in Chapter 4. 
 
View Linearity 
 
The View Linearity menu item may be used to check the linearity of a calibration curve.  The curve is 
fitted to either a linear equation or a 2nd order polynomial.  It should be noted that the View Linea ity 
screen is primarily a tool for diagnosing outliers in the calibration, and that the polynomial equations 

r
do 

not represent the actual AutoQuant Pro© quantification algorithm.  The View Linearity window is 
shown in Figure 4.32, and the feature is given a more detailed review in Chapter 4. 
 
Calibrate 
 
The Calibra e menu item initiates the calibration step that generates the sub-methods necessary to the 
AutoQuant Pro© quantification algorithms.  The method is calibrated before use in an analysis, and 
must be re-calibrated after any changes are made to the method.  The calibration function is discussed 
in more detail in Chapter 4. 

t

. 
Reload Method 
 
The Reload Method menu item loads the copy of the current method into AutoQuant Pro©.  This 
function is also available from the File menu. 
 
Copy Method 
 
The Copy Method menu item enables the user to save a copy of the current method.  The Copy 
Method function delivers the dialog box shown in Figure 5.6.  The method may be renamed and / or 
saved to another directory.  The method copied will be retained as the current method. 
 
Email Method 
 
The Email Method menu item interfaces with the users preset-up email program in order to send a 
compressed copy of the method.  This function provides both users and MIDAC Corporation 
applications scientists with a convenient way of troubleshooting applications.  Should the Email 
Method function fail for any reason, the method zip file will still be created in the method directory. 
 

 



Lock Method 
 
The Lock Method menu item is used to protect a method from unauthorized changes.  The Lock 
Method dialog box is shown in Figure 5.12.  The function should be used as a simple protected / not 
protected toggle switch for a method.  Additional security is located in the Security section of the 
Parameters dialog. 
 
 
 

 
Figure 5.12  Lock Method Dialog Box 
 
 
 
 
 
 
The Analyze Menu 
  
The Analyze menu is shown in Figure 5.13. 
 

 
 
Figure 5.13  The Analyze Menu 
 
 
The first four items on the Analyze menu are modes of data collection.  We will discuss these 
sequentially.  The method requires a valid background to be collected before any sample spectra are 
acquired. 
 

 



 
 
 
 
Single 
 
The Single mode of data collection initiates acquisition of one sample spectrum, under the parameters 
set using the Scan Parameters option from the Instrument menu.  The collection dialog is shown in 
Figure 5.14.  This dialog is identical for all collection modes. 

 
 
Figure 5.14  Data Collection Dialog 
 
The Background tab on the dialog allows the user to select a desired background for the analysis.  
Upon conclusion of data collection the spectrum will be analyzed according to the current method, and 
the results for each compound in the method will be displayed in the Analyze screen, and reported in 
the Results screen. 
 
Continuous  
 
The Continuous menu item initiates collection of a series of spectra.  Upon acquisition each spectrum 
is analyzed and the results reported.  The Storage page of the Parameters dialog allows the user to 
choose between true continuous acquisitions, or to specify a number of spectra to collect.  
Alternatively, a time limit for the analysis may be set in this way. 
 
Automatic Continuous 
 
The Automatic Continuous menu item initiates a program of data collection controlled by the Valves 
module of AutoQuant Pro©.  The Valves module is discussed in the Tools menu section of this 
manual. The valve/switch/pump operations are set-up through the valve editor sequence under the 
tools-valves pull-down menu on the top toolbar. 
 

 



 
High Speed 
 
The High Speed menu item initiates data collection with the fastest possible data acquisition 
parameters.  Under the High Speed collection program only interferograms are stored, with no 
processing step to slow the analysis.  Once data collection is complete, the interferograms may be 
converted to absorbance spectra and analyzed as normal.  The High Speed function is usually applied 
when high time resolution is crucial to the success of an experiment.  Millisecond timestamps are added 
to the interferograms during acquisition, these refined timestamps may be displayed using the 
Parameters – Numbers dialog. 
 
 
Resume Current 
 
The Resume Current menu item allows the user to recommence an analysis that has been terminated 
without changing data directories or other storage parameters. 
 
Resume Previous 
 
The Resume Previous menu item allows the user to restart the analysis using a user specified (.aqr) 
file, which holds the analysis parameters.  The Resume Previous dialog is shown in Figure 5.15.  
 
 

 
 
Figure 5.15  Resume Previous Dialog Box 
 
 
Setup Chart 
 
The Setup Chart menu item may be used to access the strip chart properties dialog box, shown in 
Figure 4.38.  This dialog box is used to configure preferences for the plot of compound concentration 
against time discussed in Chapter 4. 
 

 



The Batch Menu 
 
The Batch menu has two items. 
 
Batch 
 
The Batch menu item allows the user to reprocess data acquired in earlier analyses, or to reprocess files 
to other file types, for example interferograms (.ifg) to single beam (.sb) to absorbance (.abs).  The 
Batch dialog box is shown in Figure 5.16. 
 

 
 
Figure 5.16  The Batch Dialog Box 
 
On the Batch Setup tab of the dialog there are five push buttons to the right of the file viewer.  The 
Browse button allows the user to navigate to the location where the desired files are stored.  The 
Remove All button removes any selected spectra from the file viewer.  The Select All  button loads all 
spectra files in a folder into the batch processor.  The Unselect All button reverses this action.  The 
Toggle Select button toggles between deselecting files and reselecting those files.  Directly beneath the 
file viewer is a check box labeled Live mode:  see results as they are generated.  This may be 
unchecked for increased analysis speed.  The three parameters listed below the check box may be 
entered and set as defaults using the text boxes and check boxes.  These options should only be used 
on spectra which have no associated information stored in the (.abs) or (.spc) file.  The Storage tab of 
the dialog box allows the user to define subdirectories for data storage.  Also present are options to 

 



save single beam spectra, absorbance spectra or to process interferograms without performing an 
analysis.  The Background tab allows the user to apply a specific background spectrum to the files 
undergoing Batch processing. 
 
Rebatch 
 
The Rebatch menu item enables the user to batch process the last set of files analyzed.  This may be 
useful when results from an analysis are unsatisfactory and changes are made to a method.  The data 
may then be re-batched in this manner. 
 
 
 
The Tools Menu 
 
The Tools menu contains a number of complex and useful functions that have not yet been discussed 
in detail.  The Tools menu is shown in Figure 5.17. 
 

  
 
Figure 5.17  The Tools Menu 
 
 The menu items will be discussed sequentially. 
 
Parameters 
 
The Parameters menu item allows the user to access the Parameters dialog box discussed in Chapter 
4 and illustrated in Figure 4.5.  This dialog box enables the user to set all parameters associated with 
data acquisition, storage and analysis. 
 
Valves 
 
The Valves menu item allows the user to configure the Valves module of AutoQuant Pro©.  The 
Valves module makes it possible to automate sampling from multiple sample lines, using options from 
the Valves Sequence Editor dialog box shown in Figure 5.18. 
 

 



 
 
Figure 5.18  Valves Sequence Editor 
 
The Valve Sequence Editor consists of a sequence viewing window and a series of push and radio 
buttons on the right side of the dialog box.  The Auto Times button summons a dialog requesting 
default timings for the various steps in the sequence.  The timings are then filled automatically.  
Otherwise the timings must be calculated and entered manually.  The Load button may be used to load 
a pre-existing sequence file.  Sequence files have the file extension (.seq).  The Save button is used to 
save a sequence file to disk.  The sequence file (.seq) is saved in the AutoQuant Pro© program 
directory and not the method folder so that different methods can be loaded automatically for different 
sample lines.  The most recent edit of the sequence and sample lines is automatically saved as 
“default.seq” or “default.sl” file in the program directory although a different name was assigned.  The 
user must assign a new name to any changes to a sequence or a sample line so that the changes are not 
lost upon closing the program.  The last used sequence or sample line file (default.x) will automatically 
be loaded upon opening the program.  The Insert button may be used to place a new row into the 
sequence at the selected time point, while the Append button places a new row at the end of the 
sequence.  The Remove button is used to delete a selected row.  The Remove All button deletes all 
rows from the sequence.  The Duplicate function is not implemented at this time.  The radio buttons 
labeled Single Run and Continuous allow the user to specify whether the sequence should run only 
once or continue until manually interrupted.  The OK button saves the sequence and quits the editor 

 



while the Cancel Button quits without saving.  Before discussing the Sample Lines button, we will 
examine the process of sequence building more closely. 
 
When beginning a new sequence we start with a blank viewing window, either by default or by pressing 
the Remove All button, and pressing OK on the confirmation dialog box.  We are now ready to insert 
the first row into the sequence, using the Insert Row button.  Note that the row is split into 3 
columns, labeled Action, Time and Modifier.  The new row may be configured using the drop down 
menu in the Action column.  The options on the menu are Sample Line Switch, Analyze, 
Background Scan, Repeat Analyze and Wait Until.  An actual sequence would be application 
specific and dependant on the number of sample lines in the system, but for our purposes we will 
construct an example sequence starting with the Sample Line Switch option.  This actuates a specified 
sample line, usually of purge gas.  A sufficient time interval must be allowed for the switch (or any 
other operation) to reach completion.  This time interval is set by double clicking in the Time Column 
and entering the desired time point.  For example, we would wish to allow the Sample Line Switch 
sufficient time to actuate and flow a reasonable amount of purge gas through the gas cell, and so the 
time point of the following step should reflect this.  The time point must be entered in the format 
hh:mm:ss. The operation Sample Line Switch is also subject to a modifier, which is set using the drop 
down menu in the Modifier column.  The switch may set the line to On, Off or Safe.  The next line 
should be a Background Scan, in order to have a valid background in place for the analysis.  The time 
for this step is set at 00:00:10 to allow time for the Sample Line Switch discussed earlier.  Using these 
guidelines the example sequence shown in Figure 5.18 may be built.  Any errors in the sequence will be 
flagged upon saving the file. 
 
In order to run an Automatic sequence it is necessary to have a sample line file in the method.  The 
sample line file works with the sequence file, and has the extension .sl.  Sample Line files use 
hexadecimal instructions to control sets of valves.  An example of a (.sl) file pertaining to a sampling 
system with 13 lines and one gas cell is given in Figure 5.19.  The sample line file (.sl), in common with 
the sequence file is saved under the AutoQuant Pro© program folder and not the method folder.  Both 
the sample line and sequence files are automatically saved as the defaults.  Beginning an automatic 
analysis the defaults .seq and .sl files are loaded.  The software will continue to use these files until new 
defaults are set up. 
 

 



 
  
Figure 5.19  Sample Lines Dialog Box 
 
The dialog box shown in Figure 5.19 is accessed using the Sample Lines push button on the Valves 
dialog.  The Sample Lines dialog is similar in layout to the Valves dialog.  The Load and Save buttons 
allow the user to open and save (.sl) files.  The New button places a new line into the viewing window.  
The Remove button is used to delete lines.  The two Test buttons are used to debug the configuration, 
and will generate error warnings if mistakes are present.  The Alarms button delivers the dialog shown 
in Figure 5.20.  This dialog allows the configuration of alarms linked to sample lines and may be 
configured according to one of the three conditions discussed in the section on Modbus setup. 
 

 



 
 
Figure 5.20  Sample Line Alarm Setup 
 
 
Field Point alarms are available for configuring via the Field Point button.  The OK button saves the 
(.sl) file and quits the Sample Lines editor, while the Cancel button quits without saving.  The Setup 
button is used to access the Setup dialog box.  The Setup dialog allows the user to configure 
temperature, pressure and flow rate monitoring.  An example of a fiber optic setup table is shown in 
Figure 5.21.  Depending on the pressure transducer used, the High and Hex codes may need to be 
changed.  Typical high values are 30 or 50 psi. 
 

 
Figure 5.21  Fiber Optic Setup Table 
 

 



 
The switches are operated by the software and computers as hexadecimal entries in column one of 
Figure 5.19.  Each toggling of the switch is operated by a specific hexadecimal code.  Codes may be 
multiplied together using a hexadecimal calculator to derive new codes that toggle multiple switches or 
turns all switches on or off.  The user must determine which hexadecimal code toggles that switch.  
Typical codes are shown in Figure 5.19.  Safe mode corresponds to the toggle settings determined by 
the application and the user to be the ‘safe’ configuration.  
 
 
Once both the (.seq) file and the (.sl) file have been configured correctly, the Automatic Continuous 
item on the Analyze menu may be used to initiate the collection sequence. 
 
Alarm Log 
 
The Alarm Log menu item displays a table containing information on all alarms triggered during an 
analysis.  The Alarm Log table is shown in Figure 5.22. 
 

 
 
Figure 5.22  The Alarm Log Table 
 
If an alarm has been triggered the Alarm Log table enables the user to view the date and time of the 
alarm, the method used, the data file that triggered the alarm, the type of alarm, the compound 
responsible, the concentration of the compound and the alarm thresholds.  When running an automatic 
collection the alarm window will stay active until the alarm condition is satisfied, for example until a 
sample is analyzed with concentrations that fall between the alarm thresholds.  The alarm log however 
will retain information on any alarms triggered during the analysis.  The checkbox Sound alarm for 
information alerts makes the distinction between alerts and alarms.  An alert may be a warning of low 
disk space, for example.  If the alert sound is turned off the dialog will still display the alert with no 
sound.  The siren may not be turned off for alarms.  The method must be saved in order for this 
preference to be maintained in the next AutoQuant Pro© session. 
 
 
 
 

 



Libraries  
 
In AutoQuant Pro© Libraries are folders containing spectra that may be interrogated using the Search 
item on the tools menu.  An existing folder containing spectra may be designated as a library, or a 
library may be built from an empty folder, with collected spectra being saved to the new library.  The 
Library menu item allows the user to manage these libraries.  The Libraries dialog box is shown in 
Figure 5.23. 
 

 
Figure 5.23  The Libraries Dialog Box 

 
The display portion of the Libraries dialog shows folders that have been designated as libraries.  The 
Add Library button allows the user to navigate to a specific folder and include it in the list of libraries.  
The Remove Library button removes a folder from this list.  The buttons Move Up and Move Down 
may be used to change the order in which libraries are searched.  The Add Files… button is used to 
navigate to a set of spectra and add the files to the selected library. 
 
Add To Library 
 
The Add To Library menu item may be used to acquire data and include the collected absorbance 
spectrum in a library.  The Add To Library dialog box is shown in Figure 5.24. 
 

 



 
Figure 5.24  The Add To Library Dialog Box 

 
The dialog consists of a spectrum viewer that displays the collected spectrum, a drop down library 
selection menu, and a series of buttons.  The drop down menu labeled Library allows the user to 
specify a parent library for the collection.  The acquired spectrum will be placed in the library displayed 
in the text box.  In order for a library to be available for use in this way it must first be included in the 
Libraries list shown in Figure 5.23. 
 
Note:  If the Add to Library button is used the options in the Storage section of the Parameters 
dialog will default back to the Never Save Spectra option.  The user must re-select the desired saving 
options before continuing analysis.  
 
The Background button allows collection of a background spectrum or gives the option to specify a 
disk background.  The Collect button begins acquisition of a spectrum using the scan parameters for 
the current method.  Once the collected spectrum has been inspected for suitability the Add To 
Library button is used to include the collected spectrum in the selected library.  The Done button 
dismisses the dialog box.  The Libraries… button is not implemented at this time. 
 
 
 
 
 
 
 
 

 



Search 
 
The Search menu item is a module of AutoQuant Pro© that allows automatic comparison of spectra 
or selected regions of spectra with library standards.  This search function enables the user to identify 
unknown sample components from their absorbance bands.  The Search dialog box is shown in Figure 
5.25.   
 

 
 
Figure 5.25  The MIDAC Library Search Dialog Box 
 
The dialog consists of a viewing window for spectral display, a table of results and a series of buttons 
on the right hand side of the dialog.  The display window shows the sample spectrum to be examined.  
This spectrum may be specified using the Disk File button in the Sample section of the dialog.  The 
Libaries section of the dialog contains four buttons.  The Libraries… button allows the user to 
choose which standard libraries are to be searched.  The Regions button displays the dialog box shown 
in Figure 5.26. 
 

 



 
 
Figure 5.26  Search Regions Dialog Box 
 
The regions selected are compared against the corresponding regions of the library spectra.  The check 
box labeled Full Spectrum Search sets the search to compare whole spectra.  This option should only 
be used when comparing spectra of a single component.  Multiple regions may be selected.  The Add 
Regions and Remove Regions buttons are used to manage the search regions. 
 
The Start Search button on the Library Search Dialog initiates a search. The Stop Search button 
terminates the current search.  The results table lists the possible matches according to a correlation 
ranking system, with a ranking of 1 being a perfect match.  The table is illustrated in Figure 5.27. 
 

 
 
Figure 5.27  Search Results Table 
 
The results in this example indicate that the compound responsible for the absorbance band between 
790cm-1 and 750cm-1 is chloroform.  The buttons Best Match, Next Match, Previous match and 
Last match enable the user to navigate easily through a list of possible matches.  The act of selecting a 
match in the results table displays that spectrum in the display window.  Comparing matches with the 
sample spectrum in this way allows confirmation that the predicted match is actually the compound 
giving rise to the absorbance.  An example is provided in Figure 5.28, using the chloroform model 
outlined previously. 
 

 



 
 
Figure 5.28  Confirmation of Unknown Identification 
 
The library standard and the sample spectra were overlaid using the graphic control buttons along the 
top of the viewing window.  In this case the compound is clearly chloroform, as both bands displayed 
match. 
 
 
 
The View Menu 
 
The View menu is used to access the Toolbars options.  These are shown in Figure 5.29. 
 

 
Figure 5.29  Toolbar Options 
 
The four toolbars listed are File, Measurement, Instrument and Method.  These toolbars are illustrated 
in Chapter 3 in Figures 3.3 – 3.6.  The Reset Toolbars option restores the default toolbar settings.  
The Toggle Text Labels option toggles button descriptions on and off. 
 
 
 
The Help Menu 
 
The Help Menu is shown in Figure 5.30 
 

 

 



 
Figure 5.30  The Help Menu 
 
The Help Topics menu item is not implemented at this time.  Please refer to your electronic copy of 
the manual for searches on topics.  The About AutoQuant Pro©… menu item displays information 
on the version of AutoQuant Pro©, together with copyright and license details.  
 
 
 
Toolbars 
 
Many of the AutoQuant Pro© functions accessed using the menu system are also available via graphic 
toolbars, as discussed in Chapter 3.  The toolbar buttons may be classified into four sets.  These are the 
File Toolbar, The Instrument Toolbar, the Method Toolbar and the Measurement Toolbar. 
 
 
The File Toolbar 
 
The File toolbar provides access to file handling functions such as creating, opening and saving 
methods.  In addition to this the File toolbar contains shortcuts to the Search and Library functions, as 
well as printing and help options.  The File toolbar is shown in Figure 3.3.  The functions associated 
with each button are: 
 

 
 Shortcut to the New Method dialog 
 
 
 

 
 
 Shortcut to the Open Method dialog 
 
 

 
 
 Saves the current method to disk 
 
 
 

 

  Shortcut to the Save Method As dialog 
 
 
 

 



 
 

Reloads the current method  from disk 
 
 
 
 

 
 Shortcut to the Search dialog 
 
 
 

 
 
 Shortcut to the Add To Library dialog 
 
 

 
 

Shortcut to Print dialog 
 
 
 

  Shortcut to Help dialog 
 
 
 
The Instrument Toolbar 
 
Shortcuts to many of the Instrument menu items may be found on the Instrument toolbar, pictured 
in Figure 3.4.  The functions associated with each button are: 
 

  Shortcut to Align function, described in Chapter 4 
 

  Initiates collection of a new background, using the scan parameters from the 
current method 
 

 

 



 
 
 Initiates collection of a sample spectrum, using scan parameters from the current method 
 

  Shortcut to the View Background dialog 
 

  Shortcut to the Parameters dialog 
 
    
The Method Toolbar 
 
 
Many of the items from the Method menu may be accessed using the Method toolbar, shown in 
Figure 3.5.  These functions are used to build methods and configure alarms.  The items on the 
Method toolbar are: 
 

  Shortcut to the Add Compound dialog 
 
 

  Shortcut to the Add Spectrum dialog 
 
 

  Shortcut to the View Spectra dialog 
 
 

  Shortcut to the Add Reg on dialog i
 
 

 



  Shortcut to the Add Alarms dialog 
 
 

  Shortcut to the Add Outputs dialog 
 
The Measurement Toolbar 
 
The Measurement toolbar contains functions necessary to collect data from the instrument.  The 
functions on the Measurement toolbar may also be found in the Analyze and Batch menus.  The 
Items are: 
 

  Shortcut to the Batch dialog 
 
 

  Begins collection of a single sample spectrum 
 
 

  Begins Continuous data collection 
 
 

  Begins Automatic Continuous measurement (see Valves) 
 
 

  Begins High Speed collection of interferograms 

 



  
Chapter 6 
 
Configuring AutoQuant Pro© for Use  
 
 
 
 
Introduction 
 
The step-by-step instructions in this chapter lead you through the production of high-resolution 
reference spectra for the analysis of target compounds  

These instructions will demonstrate how to set up methods and create spectra. You may have your own 
preferences or procedures for completing tasks using FTIR spectroscopy to obtain different results.   
 
MIDAC cannot take responsibility for numbers generated from following these procedures, because 
different sample matrices and methods can produce varying results. It is the user’s responsibility to 
document how spectra were created, why specific method routines were chosen and to provide 
documentation for data Quality Control and Quality Assurance, so that the user can present a defense 
of their analytical methodology to meet data quality objectives. 
 
Application of Reference Spectra 
 
If carefully prepared and documented, reference spectra can be successfully applied to an AutoQuant 
Pro© method to obtain accurate analytical results. However, the best analytical results are usually 
obtained when reference spectra are measured using the same instrument, temperature, pressure, 
pathlength, and resolution used to measure the sample spectra. Errors can be introduced when 
measuring sample spectra under differing instrumental conditions than those used to measure the 
reference spectra.   
 
Errors can be introduced into the analysis when using spectra obtained from outside sources. Examples 
from these sources of error include the following:  
 
� Erroneous pathlength used when calculating library compound optical densities (ppm-m) 

� Non-linearity issues from hardware, software, or non-linear compound reference bands 

� Different apodization functions used to collect reference spectra and sample spectra 

� Different instrumental resolutions used to correct reference spectra and sample spectra 

� Erroneous concentrations determined or manufactured when preparing reference spectra 

� Peak broadening occurring from increased temperatures and pressures than those used for analysis 

 



� Peak shifting (x-shifting) produced from different instruments used to obtain reference spectra or 
analyze samples 

� Appearance of “hot” bands that occur at higher temperatures for some compounds and not found in 
a reference spectrum obtained under lower temperatures 

� Baseline anomalies between instruments 

� Differing window, beamsplitter, or mirror features that occur from different materials 

� Contaminants in or incomplete instrument purge when producing background  

� Double modulation 

� Use of reference spectra apodized differently than the sample spectra 

If you are going to make reference spectra that will ONLY be used on your instrument (no transfer of 
spectra between instruments), you may skip the procedure for “determining cell pathlength using 
ethylene” ( See “Instrument Set-up” below, Step 8).  and assume that the cell pathlength is arbitrarily 
“1” or a specified value (0.1, 0.15, 4 or, 10 meters), and proceed directly to “Making Reference 
Spectra,” below. 
 
The pathlength is used to determine pathlength concentration products (ppm-m), otherwise known as 
optical densities, which are used to “adjust” the reference spectrum when used on another instrument 
with a different pathlength.  For example: Making a 5 ppm CO2 reference spectrum, calling the cell 4 
meters, assigning the reference spectrum a 20 ppm-m value and entering into the software under the 
Method “4” meters.  The reported concentration will be the same if the user arbitrarily assigns a “1” to 
the cell, assigns the reference spectrum 5 ppm-m, and entering “1” in the method parameters.  
However, if you use this reference spectrum on another instrument without assigning it its proper 
optical density (20 ppm-m), you will receive erroneous results. 
 
Eliminating the pathlength calculation reduces cumulative error in the overall analysis.  Small errors in 
pathlength determination are carried directly through to the final reported number.  
 
Note that cell pathlengths may change under different cell temperatures.  Differences as much as 20 
percent may occur between room temperature and elevated temperature pathlength determinations.  
Always determine your pathlength at the same temperature used for sample analysis. 
 
Instrument Set-up 
 
The first step in producing high quality, accurate, high-resolution spectra is to prepare the instrument 
properly.  You must connect the FTIR and computer, heat the cell to the appropriate temperature, turn 
on instrument power, and allow the instrument to stabilize for a period of one to two hours. 
 

1. IF APPLICABLE, fill the MCT detector with liquid nitrogen (LN2).  If your instrument is 
equipped with a DTGS, no further detector preparation is needed.  If an InAs (indium arsenide) 
or InSb (indium antinomide) detector is used, please fill with LN2, or allow Thermo-Electrical 
(TE) cooling to stabilize for one to two hours. 

 



 

2. Purge the instrument with dry nitrogen by removing two of the ¼-inch caps located on three 
sides of the instrument (three caps on I-series only).  Connect a ¼-inch line (Teflon or stainless 
steel is preferred although others are acceptable) to one of the fittings and connect the other to 
the sample cell inlet.  This procedure allows the FTIR system to be completely purged under 
nitrogen so that a baseline background reference spectrum can be obtained.  Allow nitrogen to 
flow into the FTIR box at approximately 0.5-2.0 lpm.  Initially, much higher flow rates may be 
used to quickly purge the box and cell, but the flow must be turned down once analysis is started 
due to turbulence issues in the box. 

Note   The system must be free of any target compounds before a background reference spectrum is 
obtained.  Otherwise, any contaminant bands will be subtracted out of each sample spectrum and bias 
your results.  Carbon dioxide will purge out of the system quickly while water will take approximately 
12-36 hours before the FTIR electronics box is considered dry.  The electronics box contains a 
relatively small optical pathlength that will produce spectral bands of compounds in the gaseous phase 
within the box unless the box is purged well. 
 
Note   Many users will use liquid nitrogen Dewar boil-off or headspace for nitrogen purge.  It must be 
noted that 2-3 ppm of water and trace amounts of carbon dioxide can be present in this boil-off.  If 
water or carbon dioxide are target compounds, it is advisable to send the nitrogen through a molecular 
sieve scrubber or drying tube.  Additionally, FTIR purge gas generators are available from MIDAC. 
  
The light pipes (tubes) connecting the cell and FTIR electronics box on the I-2000 model also have 
connectors for purging.  You may purge with nitrogen in-line with the FTIR box according to the 
diagrams below. 
 
Note  A vacuum on the box may be used to generate reference spectra, but unless a near-perfect 
vacuum is achieved,  the reference spectrum will contain very low concentrations of CO2 that will be 
subtracted from your sample analysis.  This procedure is not recommended for CO2 generation of 
reference spectra at low ppm levels.  Also, unless the vacuum option is selected for your instrument 
when ordered, excessive heat may build up in the FTIR box.  The heat build-up in the FTIR electronics 
box will reduce the life of the components and void warranty.  

  
Figure 6.1  Nitrogen Purge Flow Diagram 

 



 
3. 

4. 

5. 

6. 

7. 

After the instrument has had sufficient time to purge and stabilize, you must perform instrument 
checkout.  Open AutoQuant Pro© and ensure that the instrument is connected by selecting the 
Connect button in the upper left corner of the page.  

Click on the Parameters button located in the top middle of the page or lower left side of the 
page and select “Align Mode.” Ensure that “32”cm-1 resolution is selected and that “both” is 
selected for single beam and interferogram.  Click OK. 

Select the Align button at the top left corner of the page.  

The interferogram and single beam will appear on the screen.  To see finer detail in the single 
beam, go back to the Parameters button and select up to 0.5 cm-1 resolution.  This will slow 
down the update screen. 

Click off on the “Show Voltage Values.”  The voltage values represent laser signal voltage and 
are used for diagnostic purposes. 

 

   

Figure 6.2  Align Display 

 
The display shows an interferogram (ifg) and single beam (sb) spectrum as it is collected.  The single 
beam is the overall black body energy curve for  the system over all wavenumbers scanned.  The 
interferogram is a time domain representation of the moving mirror.  Use it to view the zero phase 
differential (ZPD) that indicates the point at which the moving and fixed mirrors are at a distance such 
that all wavelengths of radiation are in phase, and perfect optical constructive interference. The 
important numbers to review are the Max (Mx) and Min (Mn) values.  The max number should be 
between 14,000 and 30,000 with a nitrogen-purged system.  If the max number is between these limits, 
then click Stop and proceed to method development. 
 

 



If the “Max” number exceeds 32,768 (clipping) or is below 14,000 (low throughput), adjust the 
detector Gain Setting. Note that the “Min” number may not be below –32,768. The fixed mirror 
alignment may also need adjustment, but doing this is not recommended unless you are familiar with 
the procedure (see below, “Fixed Mirror Alignment.”) 
 
The next important number is the “ZPD Changes” number and “ZPD Glitch Count.”  A few 
changes are OK, especially when the instrument is warming up or MCT detector has just been cooled 
off with liquid nitrogen.  If either number starts to count up rapidly, then the system is in need of repair 
or adjustment.  Please call MIDAC customer support (949-660-8558 in the USA) 
 
Gain Setting Adjustment 
To adjust the gain setting, perform the following: 
 
Open the top of the instrument with the 10 hex-key bolts.  If you have an MCT detector, then also 
remove the 5/8-inch nut on the detector fill tube and slowly pull the fill tube up and out of the 
detector.  The internal gain adjust board is located on the detector preamp and adjacent to the 
cylindrical detector (MCT) or card (DTGS). 
 

 
 
Figure 6.3  Adjust the Jumper Settings  

 
Adjust the jumper setting to change the max level.  Set around 25,000.  You can have multiple jumpers 
in ON position. By adding more resistors in parallel you will attenuate the detector signal.  Jumper A 
has most attenuation, Jumper H has lowest (highest GAIN).  It is recommended that only up to a series 
of three jumpers be used to obtain a 14,000 to 30,000 Max number.   
 
For more experienced users, a collected interferogram can be transposed to a single beam spectra down 
to 0 cm-1 to observe if the MCT detector is being operated “Too hot.”  If an MCT detector is operated 
in this configuration, it can result in non-linearity problems when target species are being measured, as 
well as negative absorbance peaks, or anomalies in the absorbance spectrum. Set the Parameters and 
then Scanning to “save region from” 0 to 4500 cm-1. The single beam spectrum will be displayed in 
the open window.  Examine the single beam arbitrary y-value around 400 cm-1.  The energy with KBr 
or MCT optics should eliminate all energy (close to zero y value) below this region.  If it does not 
indicate very low energy, or if it slopes upward, too many photons may be hitting the detector.  In this 

 



situation, we recommend that a screen be used in front of the detector to cut down on the photons 
striking the detector.  This is not necessary if you are producing your own reference spectra  (for more 
details on this, contact MIDAC applications department (919-522-2032 or 919-608-0954) 
 
 
Fixed Mirror Alignment 
(Note:     Perform only if familiar with procedure) 

 

The fixed mirror alignment adjusts the rotation of the fixed mirror to optimize throughput. This 
alignment need not be performed routinely.  This procedure should only be performed after rough 
shipping or damage to the FTIR, or as part of an annual service. 
 
The “Max” number  is an arbitrary relative measure of infrared throughput and is related to the 
number of bits in the ADC.  The value can be changed electronically or by physical attenuation. Adjust 
the hex keys and watch peak height. Note that  very small movements result in very dramatic changes in the 
interferogram. Do not exceed 32,768 or –32,768 . 
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Figure 6-4  Interferogram Peak Height 

 

 
Figure 6.5  Fixed Mirror Alignment 

 



 
Note    You should allow for a minimum of one half-hour for the instrument to stabilize after making a 
fixed mirror adjustment. 

Once you are satisfied that the FTIR is functioning properly, click on “Stop” in Align Mode.  We are 
now ready to determine the optical pathlength of the cell, if desired. 

Parameter Set-up and Pathlength Determination 
 

1. Click on “Method” tab at top left corner of screen. 

2. Click on “Parameters.” 

3. Click on “Scanning.”  Set up number of sample scans.   

Note:   Increasing the number of scans will result in a better signal-to-noise ratio.  Signal to noise 
does not improve linearly however with increasing number of scans.  Signal to noise is directly 
proportional to the square root of the time spent scanning, so that increasing the scans from 32 to 64 
does not result in doubling the signal to noise ratio, but increases it by a factor of 1.414.  This is a general 
principle, so that doubling the time spent scanning always results in improvement of signal to noise by a 
factor of the square root of 2.  It is apparent from this consideration that this approach to maximizing the 
signal to noise ratio is subject to the law of diminishing returns, and that it quickly becomes impractical to 
seek further improvements after around 1028 scans.  It should also be noted that though the signal to 
noise ratio is proportional to the square root of the time spent scanning, after 1/f noise (characteristic of 
the electronics used) is at a sufficiently low level the time spent scanning may be substituted for the 
number of scans.  The scan speed of the MIDAC is sufficient to overcome the 1/f noise.  The effects of 
resolution on the signal to noise ratio are discussed in Chapter 1. 

4. Choose scanning interval for continuous (“as fast as possible”), or add a delay between scans. 

5. Choose number of background scans. The number of background scans should be equal to or 
greater than the number of sample scans. It is preferable to subtract out a background single beam 
with less noise than the sample single beam.  

6. Choose when to have “new background prompt” appear. 

Note   It is up to the user to determine the appropriate interval at which to collect a new background 
scan. You should flush the system with nitrogen before collecting a new background, unless it is 
desirable to have the background contain compounds at appropriate levels that you want subtracted out 
of the sample spectrum. New backgrounds should be collected when you can see: 1. a sloping baseline, 
2. a rise or fall in some portion of the baseline, or 3. humps in the baseline that may be present from ice 
bands associated with some liquid nitrogen-cooled detectors that have lost some of their Dewar 
vacuum over time.  
 

7. Choose resolution and “save region from.” 

Note   Typical MCT regions with zinc selenide (ZnSe) windows will produce good data from 650 to 
4500 cm-1.  KBr windows and beamsplitter can go down to 400 cm-1.  InSb and InAs detectors with 
CaF2 windows can typically measure from 2000 to 7000 cm-1. 

 



8. Choose apodization function. Default is Triangle. 

Note   Apodization default is triangle, although many people use medium Beers Norton.  Boxcar is 
essentially no apodization.  The MIDAC library has been apodized to triangle. 

9. Choose phase correction.  Default is Mertz. 

10. Choose gain setting.  Default is 1. 

Note   The gain setting will electronically increase the signal obtained from the detector.  It does not 
improve signal-to-noise ratio because it amplifies both signal and noise.  However, it can be used for 
very small signals down in the baseline so that the software is able to quantify better.  Linearity issues 
can occur with an auto gain.  It is still important to not exceed +-32,768 in the align mode.  This is 
called “clipping.” 
 

11. Click “Method” under Parameters. 

12. Choose Linearity: Default is non-linear. 

Note   Linear mode will only calibrate the method with a straight line from (0,0) to the reference 
spectrum ppm-m concentration labeled as “primary.”  To select the primary spectrum, double click on 
the column marked “primary” at the same row as the spectrum wanted as the primary.  Many 
compounds measured over large concentration intervals or orders of magnitude will be non-linear in 
nature.  MIDAC recommends using multiple reference spectra that bracket the expected concentrations 
of your target compounds with a non-linear method.  The software will then accurately fit the unknown 
to the calibration curve.  Having only one reference spectrum in a non-linear method produces the 
same result as using a linear method.  The software will then only fit a curve from (0,0) to the reference 
spectrum optical density. 
 

13. Choose baseline.  Default is Linear, Embedded Baseline Correction (Single Baseline).   

Note   The baseline that has been tested and is easily defensible is a “single baseline embedded.”  The 
software will then automatically baseline-correct the reference spectra appropriately prior to performing 
CLS analysis.  The other baseline options do have benefits for special applications.  It is up to the user 
to determine if any other baseline correction is warranted.  Baseline correction of reference spectra 
manually may be needed if other options are chosen. 
 

14. Choose if you want “on the fly” linear calibration.  Default is “unchecked.” 

15. Choose Exclusion Criterion.  Default is 2500. 

Note   Exclusion Criterion is used for peak detection.  It can be made more sensitive by increasing the 
number.  It is not recommended to change from 2500. 
 

16. Choose any Pre-Processing, if needed. Default is none. 

Note  Pre-processing is used for special applications.  Taking a first derivative is used to “straighten” 
out curving baselines for very small absorbance peaks or using synthetic backgrounds.  The 
Hydroquant method is used specifically for measuring extremely small (ppbv) concentrations of 

 



moisture in a sample matrix.  This is only used specifically for this application. See Hydroquant section 
of manual.   
 

17. Choose Interpolation algorithm.  Default is Piecewise (PWCI). 

Note  The interpolation algorithm uses two accepted procedures for fitting unknown spectra to a 
calibration curve that falls between two reference  spectra.  The PWCI is best for complex multiple 
compound matrices. The PWAI can be used for single component matrix evaluation. 

18. Click on Storage, and choose options. 

Note  Under Storage, it is important to note that if the data is to be legally defensible, the sample 
and background interferograms must be saved.  This is the raw data and is not easily manipulated.  
All other spectral types can be generated from the interferograms.   

SPC or ABS extensions are interchangeable in AutoQuant Pro©.  If using other spectral manipulation 
packages, .SPC is recommended. 

19. Click on “Memo Fields.”  

Note    Clicking on the arrow pointing to the right at the end of the Memo field will prompt the user to 
enter abbreviations.  AutoQuant Pro© must be able to recognize these abbreviations in order to report 
the data accurately. Enter them in place of    the “$X.”  These abbreviations will attach to each sample 
spectrum collected. 
 

20. Click on “Paths.”  Enter appropriate directories for fields.  Choose any  back-up directory or 
storage device.   

21. Click on Auto-Resume.  You must run the set-up procedure before you can use this feature.  If 
the computer looses power, the software will automatically start-up and continue to collect spectra 
if chosen.   

22. Click on Analog Out, and choose appropriate device if sending signal out to a control room or 
DAS. 

23. Click on “Cells.”  Add in the appropriate pathlength.  If you do not   know    yet, then fill this in 
after you’ve determined pathlength. Filling this in is important  in order to produce accurate 
concentrations. 

Note   If your instrument is set up to read in Temp and Pressure readings through the RS-232 port or 
the fiber optic card readout, you do not have to use the default Temperature and Pressure option.  The 
software will automatically correct the sample spectrum concentrations for temperature and pressure 
according to P2/P1 and T1/T2 from the default or directly from the temp and press controller.  (See 
T&P setup section in Chapter 4)   
 

24. Click on “Gas Flow,” and enter in a flow rate other than “1” if you are going to report numbers 
as a mass per time (lb/hr). 

 



25. Click on “Infrared Throughput,” and check the box if you want the software to alarm visually 
and audibly when the energy throughput falls below these predetermined levels. Low energy can 
be caused by a drop in the liquid   nitrogen  in a cooled detector, dirty optics, fogged beamsplitter, 
misalignment, or very high concentrations of compounds in the sample cell. Default for this box 
is unchecked. 

26. Click on“Numbers,” and then enter user preferences. 

27. Click on “Test,” and enter  user preferences. 

28. Click on “OK” 

29. Click on the “New” tab on the top right toolbar to open a new method.     Enter the appropriate 
fields and click on Create. 

Note   The default directory for new methods is under the AQPro\Methods\ directory. Most users 
will enter the same subdirectory and filename for the new method to avoid confusion. The method 
description enables the user to distinguish this method from others.  Anything can be placed into the 
description field but no DOS characters should be placed into the subdirectory and filename. DOS 
characters include .,:;/ %\  
 

30. Click the “Compound” tab on the top left toolbar. Enter the appropriate compound. For this 
exercise, type in “ethylene.” Add the molecular weight if reporting mass emissions instead of 
concentrations.   

Note   You should already have an ethylene reference spectrum for your    pathlength determination. If 
you do not, use the MIDAC Reference Spectrum “Ety_H19A ethylene, I2001-V, 121C, 1 atm N2, 
207.6 ppm-m Gain=001” available from MIDAC or the Standards Library. If you prefer the EPA 
spectra, then the 5CS0124B, 225 ppm-m spectrum is good for a 20 ppm standard with a 10M cell. 
 
Note   For ethylene (or any other target compound), it is best to use a reference spectrum that was 
produced at the same temperature as the sample cell temperature you will be using to analyze samples.  
AutoQuant Pro© will adjust for Temperature according to the factor T2/T1 absolute, but will not take 
into account subtle effects from “peak broadening” or “hot bands” that are variably dependent on the 
compound, but can add error into your analytical confidence. The MIDAC Library does contain other 
spectra at other temperatures for ethylene. 
 
Note   The EPA library spectra and MIDAC’s library spectra are apodized with “Triangle.”  They 
should not be used with any other apodization parameter in a method. All sample spectra should be 
collected with the same apodization as the reference spectra. 

31. Click on the “Spectrum” tab on the top left toolbar and choose the appropriate directory that 
your reference spectra have been placed.  For this exercise, choose   the Ety_5A ethylene, I2001-
V, 25C, 1 atm N2, 206.6 ppm-m Gain=001 available from the MIDAC Standards Library.  
Ensure that the spectrum parameters are pulled into the software correctly and then choose 
“OK.” 

32. Click on the “Region” button, then click on ”New Region.” 

 



33. Input 870 to 1040 in the appropriate space.  Then click on “Done.”  

34. Click on the “Calibrate” button. 

Note   The calibration time will depend on the number of compounds and number of reference 
spectra per compound.  The following are timing comparisons with AutoQuant Pro©. The timings 
were taken on a 1.2Ghz system with 1GB of memory and using a fast NTFS-formatted 75GB disk. The 
method has 7 compounds with 7, 3, 4, 2, 4, 2, 4 standards in those compounds for 37,632 sub-methods 
7*(7*3*4*2*4*2*4): 
 
Prediction times are total times for all 56 absorbance samples done in batch mode: 
 AQPro calibration prediction on-demand calibration: 30sec2min5sec 
 full cal: 58sec 1min 48sec 
 

35. Click on the “Analyze” tab at the top left toolbar. 

36. Click on “Continuous” on the top left toolbar.  You can now change the base directory, 
subdirectory, base name, and memo field as you see fit. We recommend that you use the “collect” 
folder as the base directory. 

Note   For this exercise, enter “ethylenePL” into the subdirectory position, leave the base filename as 
“C” (this is the prefix for all generated files-for example, C0001,C0002,etc.). In the memo field, enter 
$R, $S, $T, $P, $L.  The software will then automatically record resolution, number of scans, 
temperature, pressure, and pathlength.  This information will be tagged to the spectrum and 
interferogram files.  Do not click on “OK” yet. 

 
37. You must now ensure that the system (FTIR box and Cell) have been properly purged with 

nitrogen for the proper period of time.  When you’ve provided    enough time for proper purging 
of the system, ensure that the purge flow has been cut back to between 0.5 to 2.0 lpm and click on 
the ”Collect” button 

Note   If the purge flow rate through the FTIR Electronics box and/or sample cell is too great, then 
you will have greater noise in the spectra from turbulence effects.  Maximum flow rate through the box 
is 2.0 lpm.  The sample cell flow rate depends upon cell type. It is recommended that less than 6.0 lpm 
be used as a sample cell flow rate for a 10 m cell and 1 lpm for a 3 m cell. 

 
38. You must now collect a new background or select an existing  one. Under the “Continuous” tab, 

click on the “background” tab and choose “collect from instrument.” 

39. The FTIR will then start to count up the number of scans you selected and then show a 
“reference single beam spectrum” .rsb.  

40. You must inspect the single beam spectrum visually to determine if the quality   is good.  The 
spectrum should look somewhat like below: 

 



 
Figure 6.6   Single-beam Spectrum Sample 1 
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Figure 6.7     Single-beam Spectrum Sample 2 

 
Note   The single beam spectrum in Figure 6.1 shows a proper energy ratio between the high and low 
wave numbers and is indicative of a properly functioning instrument.  The single beam in Figure 6.2 
shows a properly functioning instrument but also shows a not completely purged system.  The wave 
numbers at approximately 1400-2000 and 3500-4000 are indicative of moisture (H2O) molecules in the 
system.  It is very difficult to remove all the water, and some water is okay.  The wave numbers at 2300 
to 2400 are CO2 and can be purged out of the system.  A very small amount of CO2 is okay if you are 
not measuring CO2.  When measuring CO2 it is imperative that it be completely removed from the 
background or the software will subtract that CO2 amount from your sample and bias the CO2 
concentration in your sample low.  This is true of anything in the single beam background spectrum. 
 

41. If you are not satisfied with the single beam, click on the “Collect from Instrument” button 
again.  

 



42. When you are satisfied, click on “OK” and the software will use the last collected reference single 
beam to collect the data, unless another background is recorded or selected by the user. 

43. You are now ready to determine the Pathlength using ethylene. 
 

44. Disconnect the nitrogen line to the cell only.   
 

45. Flow a known concentration of ethylene through the cell at 1-2 lpm at the cell temperature that 
will be used for sampling.  Do not exceed 30 PSI on cell.  10 PSI is adequate on the regulator. 
Flow ethylene through the cell for an appropriate amount of time to get at least 5 cell turnovers 
(approximately 0.2 L volume in 3M cell; 2 L Volume in 10M cell)  (It is important to not flow 
sample through your cell too quickly as turbulence effects will create added noise in the 
spectrum.  Two lpm is maximum for a 3, 4 meter cell, 15 lpm for a 10 meter cell, and less than 4 
lpm for a 20 meter cell.) 

 
46. (Optional) To determine pathlength, go back to Parameters and choose “Cells.”  Enter the 

concentration of the gas cylinder in ppm in the box for cell pathlength.  The reported 
concentration generated by AutoQuant Pro© will be the optical pathlength of the cell.  After 
you get the correct pathlength, change the cell’s pathlength number to the newly acquired optical 
pathlength before making measurements. 

 
47. Check entry fields and click on OK under the “Continuous” tab.  The analyzer will start up and 

begin counting to the specified scan numbers.  
 
Note:  To collect a single spectrum, click on the “Single Measurement” tab; or if you want only to 
collect interferograms without any software conversion to single beams or absorbance spectra, click on 
the “High Speed” tab.   The “Automatic” collection tab is used only for valve control (See section on 
Valve Control in chapter 5). 
 
20 ppm in N2 balance is recommended for a 10m cell.   
40-50 ppm in N2 balance is recommended for a 3m cell.   
2000 ppm in N2 balance is recommended for a 10cm cell.  
20,000 ppm in N2 balance is recommended for a 1 cm cell.  
 
Note: The bottom right side of the screen will show the absorbance spectrum while the bottom left 
side will show the pathlength being reported as the concentration.  Allow the pathlength number to 
stabilize and when the graph shows the ethylene pathlength as stable, record the cell pathlength. The 
ethylene spectrum should look something like the spectrum in Figure 6.7.           
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48. When the pathlength has reached a steady-state condition, as evidenced by the graph, 
absorbance spectrum, and reported concentration, click on the Stop button on the toolbar.  
Enter the new pathlength value only under the Parameters “Cells” section under “Pathlength.” 

 
49. To change the graph options and/or background colors, select the buttons in the upper right 

corner of the “Analyze” page.  Spectral window options can be selected by right-mouse clicking 
on the spectrum view window on the lower right corner of the “Analyze” page. 

 
50. To view results, click on the “Results” tab. 

51. You are now ready to make your own reference spectrum or use library spectra for your Method.  
If using library spectra, repeat the procedure used for making the ethylene pathlength method. 

Making Reference Spectra 
 

1. Reconnect the nitrogen gas stream to the gas cell.  Also keep the FTIR box purging 
(approximately 0.5-2.0 lpm). 

2. Set your parameters under the “Parameter” field.  Reference spectra should be collected with a 
large number of scans for quality spectra (i.e., 64 or 128). As discussed previously, the number 
of scans will determine the signal-to-noise (s/n) and quality of the spectrum.  It is up to the user 
to determine the data quality objectives of the analysis.  Some users will use 32 for DTGS and 
64 for MCT.  Others will use 128 or 256. 

 
3. Click on the “Single” button on the left side toolbar. 

4. Enter “library” under the “Subdirectory” field. 

 



5. Enter appropriate data in the fields. Do not use DOS characters in the subdirectory name. Enter 
a distinguishable name for the file in the “Base Name For Data Files” field, for example, 
“Ethylene20ppm.” 

6. Click on the “background” tab in the same window. Click on “collect from instrument.”  
When satisfied with the background, click on OK. 

7. The software will collect a spectrum of the compound and save it under the “library” folder you 
created or under any folder you choose. 

8. You can add any collected spectrum to any folder including the library simply by clicking on the 
“Add to Library” button on the upper right toolbar and selecting a folder to place the spectrum 
into.                                                                   

Note  It is recommended that you collect more than one spectrum of the target library spectrum to 
determine if steady-state conditions exist.  You can collect multiple spectra and then review them for 
stability.  Multiple spectra can be averaged later into an averaged spectra through another spectral 
manipulation package. 
 

9. When you have completed your library spectra, you are ready to generate a Method. 

 
Adding Spectra to a Method 

1. Either “Open” an existing Method or click on the “New” button on the top  right toolbar.  
AutoQuant3 methods can be imported by clicking on the “File” menu on the top toolbar and 
selecting “Import AQ3 method.” 

2. Check your “Parameters” menu to make sure you’ve chosen the correct parameters for your 
method. 

3. Enter a subdirectory, filename, and Method description in the appropriate    fields. 

4. Click on “Create.”  

5. Click on “Compound” and add Name and Description (optional).  Add Molecular Weight only 
if you want numbers reported in Mass Emissions (lb/hr).  A flow rate will then be needed. 

6. Click on “Spectrum” and browse to the appropriate folder by clicking on one of the buttons 
associated with the “look in” field. 

7. Double click on the absorbance file.  The file must have an .abs or .spc   extension. 
 

8. Click on “Region” on the top left toolbar. 

9. Click on ‘New region” and either enter the region numerically or click on the radial “New 
Range” button and drag the mouse by holding down the left-mouse key and then releasing to 
select your region for quantification.  You may zoom in or expand any part of the spectrum for 
finer detail by using the appropriate keys.   

 



10. Click OK and the spectrum selected will be used as the new reference spectrum for that 
compound. 

11. Continue this procedure until you’ve placed all your target compounds and any interferences into 
the method.   

12. Click on “Calibrate.”  The method is completed. You will want to collect new backgrounds as 
needed throughout your analysis of samples. 

 

It is important to collect backgrounds periodically as this will affect the quality of you data and 
hence accuracy and precision.  The software can handle gently sloping baselines and offset 
baselines very well.  However, when the baseline curves up or down in both directions, some 
error may be introduced.  By collecting backgrounds periodically, you eliminate the baseline 
anomalies caused by temperature differences, changes in LN2 levels, deposits on optics, ice 
formation, etc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Chapter 7 
Developing a Method 

In the preceding chapter we covered the basic details and mechanics of creating an AutoQuant Pro© 
method.  In this chapter we will discuss the general philosophy of method development.  FTIR is a 
uniquely powerful analysis technique, using fundamental physical properties of the analyte molecules to 
form a complete picture of the components in a matrix in a single measurement.  The absorbance spectra 
gained from the mid infra-red region of the electromagnetic spectrum contain information of both a 
qualitative and quantitative nature, allowing identification of components and quantification in a single 
step.  Getting the most from such a large volume of information of course involves very careful 
interpretation, and it is the purpose of this chapter to provide general guidelines for successful analysis of 
infrared spectra using AutoQuant Pro©.  Remember that unless the method is optimized erroneous 
results may be reported.  However, two different methods can easily achieve the same results for each 
target compound.  This chapter focuses on achieving accuracy in the method in a logical and defensible 
manner.   

Consider a matrix composed of a mixture of components.  The spectrum from the matrix will contain 
absorbance bands from all infrared active components (those whose modes of vibration cause a change 
in dipole moment).  Such a spectrum is shown in Figure 7.1. 

 

Figure 7.1  Saturated Spectrum of a Gas Mixture 

Immediately obvious on inspection of the spectrum in Figure 7.1 are the two large absorbance bands 
between 4300cm-1 - 2900cm-1 and 2200cm-1 – 1000cm-1.  These bands are due to water, and unless dealt 
with water is the principle obstacle to successful data interpretation as it interferes over such a wide 
region.  In fact, this spectrum is an extreme case, with water and carbon dioxide present at high levels. 
Levels high enough to completely attenuate the photons in these regions making none available for the 
detector.  Looking at these water bands in detail, we notice that some regions of the bands appear 
perfectly flat, as shown in Figure 7.2. 

 



 

Figure 7.2  Saturated Water Bands  

At first glance it may seem that this is good news, the absorbance recorded is zero, therefore the water 
does not absorb at this frequency.  Unfortunately the opposite is true, these flat regions are said to be 
Saturated.  Note that the flat regions may be at zero or at the highest peak heights in the region.  This 
is due to detector non-linearity.  You may see the saturation either way.  Comparing the water band in 
Figure 7.2 to the band in Figure 7.3 we find that the flat regions in the first figure correspond to regions 
of highest absorbance.   

 
 

 
Figure 7.3  Unsaturated Water Spectrum 
 
 
To understand why the saturated regions are displayed as zero we must review some FTIR theory.  A 
Fourier transform infrared (FTIR) spectrometer records Interferograms as raw data.  These 
interferograms consist of a plot of detector response against time and thus in the time domain.  
Although a full discussion of interferometry is beyond the scope of this document, an example of an 
interferogram is shown in Figure 7.4. 
 

 



 
Figure 7.4  Interferogram 
 
The largest peak (ZPD) corresponds to the point at which interference in the interferometer is 
completely constructive.  A fast Fourier transform (FFT) is applied to the interferogram, the output of 
which is a single beam spectrum (see A Crash Course in FTIR in Chapter 1), examples of which are 
shown in Figures 6.6 and 6.7.  The next step is to transform a single beam spectrum into a transmission 
spectrum.  This is achieved by ratioing a single beam sample spectrum with a single beam background 
spectrum.  An example of a transmission spectrum is shown in Figure 7.5. 
 

 
Figure 7.5  Unsaturated Transmission Spectrum 
 
The transmission spectrum shown represents carbon dioxide at 2500 ppm-m.  The y-axis shows the 
percentage of radiation from the source reaching the detector, with wavenumbers on the x-axis.  A 
transmission spectrum is related to component concentration logarithmically and not linearly.  For this 
reason, transmission spectra do not feature heavily in AutoQuant Pro© (except for single beam quant 
(SBQ) see associated Chapter), although the software may be configured to examine these spectra.  In 

 



order to generate a spectrum with a linear relationship between band intensity and component 
concentration, the negative logarithm (base 10) of the transmission spectrum is taken to produce the 
absorbance spectrum.  In a saturated region, the transmission will be zero and any logarithmic 
relationship fails.  When this failure occurs, the software will set the absorbance values to zero (if the 
single beam values in those regions are negative due to some non-linearity of the detector as common 
in MCT detectors).  It is now clear that the parts of the water and CO2 bands that show zero intensity 
are saturated, and cannot be used in any analysis.  Even in such unfavorable circumstances as these, 
there are still many regions in the spectrum that we can use for analysis.   

 

Sample

Reference

Figure 7.6  Nitrogen Dioxide and Water 
 
In Figure 7.1 it is not immediately apparent that a significant amount of nitrogen dioxide (NO2) is 
present.  Consider the region depicted in Figure 7.6.  AutoQuant Pro© determined this region to 
represent a NO2 concentration of 39 ppmv.  This is consistent with the reference spectrum 
concentration of 30ppm.  Figure 7.7 shows the contaminated spectrum in the previous figure after 
subtraction of water.   

 

Treated Sample Spectrum

Reference Spectrum

 



Figure  7.7  Sample Spectrum After Water Subtraction 
 
 
 
While water interferes in this region, AutoQuant Pro© is able to correct for this interference so long as  
 

a) The absorbance due to water is not saturated 
b) Moisture spectra (or other interfering compound) are used in the method, with analysis 

regions overlapping those of the target compound.  These water spectra should have 
absorbance bands of similar intensity to the sample water absorbance, and be recorded at 
the same temperature and pressure as the sample spectra. 

 
This general principle is true of all interferences.  While some iterations may be necessary to find the 
best combinations of reference spectra and analysis regions, analysis of even very complex spectra is 
possible.  In order for the interfering band to be taken into account in the analysis, it is necessary to 
analyze for the interferent over the same region as the analyte.  As has already been stated, this is not 
possible if the interfering band is saturated as the subtraction fails.  A better solution in some cases 
would be to find bands in the spectrum which are unaffected by interference.  Consider the ammonia 
bands in the same sample spectrum shown in Figure 7.8. 
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may be used to give good quantification of NO at single digit ppm levels and above as long as the same 
region is used for moisture for subtractive purposes. 
 
The following is an exercise in the analysis of a complex matrix containing ammonia, nitric oxide, 
nitrous oxide, nitrogen dioxide, sulfur dioxide, hydrogen cyanide, carbonyl sulfide, carbon monoxide, 
carbon dioxide and water.  This matrix is represented by the spectrum shown in Figure 7.9. 
 

 
Figure 7.9  Sample Spectrum 
 
The spectrum in Figure 7.9 contains saturated CO2 bands together with high levels of water (see the 
positive saturated bands as compared to the zero saturated bands).  This presents a challenge, 
particularly with respect to quantification of NO.  How do we set about developing a method to 
analyze this spectrum?  The first step is the recording of reference spectra (including the main 
interfering species carbon dioxide and water) according to the procedure set out in Chapter 6.  These 
reference spectra should be recorded at the same temperature and pressure regime as samples are to be 
acquired under.  In addition to this, reference spectra should be collected at concentrations that 
encompass the expected concentrations in the samples, so as to enable ‘bracketing’ of the unknown 
sample components concentrations.   **In order to maximize the accuracy of these reference 
spectra, it is necessary to remove absorbance bands of contamination, and to correct any 
baseline defects.  Unless contaminating absorbance bands are removed in your reference 
spectra, your results will be biased low for those target compounds that are contaminants in 
the reference spectra of other target compounds. ** This may be achieved using GRAMS.  For 
example, take the NO spectrum, shown in Figure 7.10. 
 
 

 



 
 
Figure 7.10  Nitric Oxide at 100ppm 
 
The spectrum shown in Figure 7.10 represents nitric oxide at 100ppm.  Also present in the spectrum is 
a large band at approximately 3300cm-1.  This band is due to ice forming on the liquid nitrogen cooled 
detector window after a long period of operation.  This anomaly can be ratio’d out by taking a new 
background spectrum periodically.  This is characteristic of a detector Dewar that has slowly lost 
vacuum over time and needs to be re-evacuated.   Another less obvious impurity is the small nitrogen 
dioxide band centered at 1610cm-1.  While smaller, this band is potentially more damaging to an analysis 
as it could bias quantification of NO2 to the low end.  These impurities are removed in the following 
way: 
 

1) On the GRAMS menu select Applications – Utilities - Zap  
2) Right click in the lower pane to select zap regions.  These regions may be clicked and dragged 

until the desired area(s) are covered, as illustrated in Figure 7.11. 
 

 



 
Figure 7.11  Zap Regions 
 

3) Once the regions are selected click OK – Add new (it is vital to retain the original spectrum for 
future reference). 

4) The regions selected are now smoothed.  However, the baseline still requires correction. 
5) From the menu select Applications – Baseline Correction 
6) Select the options Multi Point, Force Points Onto Data and Level And Zero as shown in 

Figure 7.12. 

 
Figure 7.12  Baseline Correction 
 

 



7) Click OK, then Replace 
8) Save the corrected spectrum before closing GRAMS 

 
Once all reference spectra are corrected they may be loaded into the method.  We can now examine the 
reference spectra for analysis regions, using the View Spectra button.  The spectra are shown in Figure 
7.13. 
 

 
Figure 7.13  View Spectra Window 
 
Using this tool we can zoom in on analyte absorbance bands and check for interfering species.  
Zooming in on the NO band at 1900cm-1 we see interferences from both water and COS, as shown in 
Figure 7.14. 
 

 



 
Figure 7.14  Nitric Oxide From Water And Carbonyl Sulfide 
 
 
From the information in this view we can decide how to proceed.  The absorbance bands of the 
interfering species are not saturated.  In fact they are low enough (below 0.8 absorbance units) to 
behave linearly, in accordance with Beer’s law.  This means that we do not have to choose regions that 
avoid the water and COS, AutoQuant Pro© will be able to subtract the interferences as part of the 
analysis.  The most difficult interferent to treat in this way is usually water, as it is a highly non linear 
compound due to its strong inter molecular forces causing deviations from Beer’s law and does not 
transfer well from instrument to instrument.  Only water spectra recorded on the spectrometer used in 
the analysis should be considered for inclusion in the method.   
 
 
 
 
 
 
 
 
 

 



Important Note On Water Interference 
 
As mentioned above, water interference is particularly challenging to subtract accurately from 
sample spectra.  Water has broad absorbance features in the mid infrared, and has an apparent 
non-linear response to concentrations changes, even at low levels.  For this reason it is 
important that water spectra included in the method are acquired on the spectrometer used in 
the analysis, and that the spectra are recorded under the same temperature and pressure 
regime used in the analysis of sample data.   In addition to this, the concentration intervals 
between water spectra should be as small as possible, i.e. the larger the range of water spectra 
in the method the better the subtraction.  If these precautions are taken excellent spectral 
subtraction are achievable.   
 
It is possible to select regions for the other analyte compounds that are subject to little or no 
interference.  The regions chosen for this method are shown in Figure 7.15. 
 

 

 
 
Figure 7.15  Analysis Regions 
 
 
To illustrate the importance of including interferences in the method, consider the results table shown 
in Figure 7.16 
 
Species Actual Conc. 

/ppm 
Analyzed Conc. / ppm Without H2O / CO2 

NH3 10 9.99 18.16 
CO 25 25.45 41.63 
COS 12 12.31 17.36 
HCN 30 29.55 26.93 
NO 100 100.76 33.54 
NO2 25 25.23 25.60 
N2O 50 49.54 43.20 
SO2 50 50.64 83.51 

 



Figure 7.16  Results 
 
Once all interfering species as well as target species are included in the method, accurate results will be 
generated.  As the results demonstrate, interferences that are unaccounted for can result in erroneous 
results.  
 
The final topic in this section is calibration curves.  The calibration curves for a particular compound 
may be viewed by right clicking on a compound and selecting View Linearity from the context menu.  
The View Linearity function is discussed fully in Chapter 4.  While the curve fitted to the data points 
is not representative of the quantification algorithm, it is an important diagnostic tool.  Consider the 
curve for ammonia shown in Figure 7.17. 
 

 
Figure 7.17  Non-Linear Ammonia Calibration Curve 
 
Curves may exhibit apparent non-linearity due to one or any combination of the following regions: 
 

1) The physical properties of the target molecule 
2) The regions selected for analysis 
3) The wide range of concentrations in the calibration 

 
This non-linearity does not necessarily present a problem, as long as it is recognized and the curve 
possesses sufficient data points for accurate interpolation.  With the curve in figure 7.19, accurate 
measurements of ammonia samples of concentrations in the 200ppm – 400ppm region may be 
problematic, as the calibration between the points at 200ppm and 400ppm may exhibit excessive 
curvature.  If it is not possible to fill in the gap with reference spectra at 250ppm, 300ppm and 350ppm, 

 



then it may be necessary to make the calibration curve more linear by choosing an analysis region of 
lower (and hence more linear) absorbance. 
 
In conclusion, AutoQuant Pro© is capable of analysis of complex gas mixtures.  The development of a 
suitable method is however crucial to the success of such an analysis.  It must be stated that each 
method should be Matrix Specific, and that what works in one case may not be the best method for a 
different set of measurements.  The building of methods becomes easier with practice, and as long as 
the principles outlined here are adhered to accurate results can be generated for most matrices.  An 
important tool is the software is the SEC number and the residual spectrum.  These are important tools 
for optimizing methods.  The SEC tells you how well a predictive model works (CLS) and the residual 
spectrum is a visual representation of the SEC.  By using an iterative process and examining the SEC 
and residual to obtain the lowest SEC achievable, you can easily obtain highly accurate results. 
 
MIDAC’s applications department is available to answer any questions you have on method 
optimizations or source sampling.  There may be a charge for in depth method development and 
optimization.  In addition, target compound spectrum generation at user specified concentrations, 
temperatures, pressures and optical densities are available through MIDAC’s laboratories for a fee.  Our 
fully outfitted laboratory is also available for training courses and client use for hardware and software 
training and reference spectrum and method development. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



Chapter 8   
Open-Path Systems (Supplement) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 8.1  Bistatic Telescope and Source 
 

 
Figure 8.2  Illuminator without Telescope 
 

 



 
Figure 8.3  Aries Open-Path Monitoring System 
 
MIDAC Corp. manufactures three types of Open-Path, ambient monitors (AM-FTIR) systems, mono-
static, bi-static, and Aries.  The difference between the monostatic and bistatic is that the bistatic uses 
an external source that sends photons to the instrument and then to the interferometer and then 
detector.  The monostatic uses an internal source to send photons to the interferometer and then to an 
external retro-reflector and back to the detector.  The disadvantage of the monostatic unit is that only 
half of the photons are sent to the retro reflector so that the maximum distance that you can use the 
system is at least cut in half.  Since the IR beam is modulated prior to being sent to a retroreflected unit 
(Monostatic), the IR beam must first pass through the beamsplitter where half of those photons are 
attenuated.  The advantage of a monostatic unit is that it is easier to align the retro reflector because the 
infrared beam is reflected back to its source although it may be slightly off axis.  Retro reflectors are 
typically three mutually perpendicular surfaces available in different types of reflective materials, 
typically being gold or silver.  Retro reflectors are typically referred to as a corner cube or a prismatic 
retro reflector. 
 
The bistatic sources are 12VDC external sources with a silicon carbide glower (400-7000 cm-1) or 
quartz halogen source (1800-7000 cm-1) mounted in the center of a parabolic mirror. 
 
The systems can also be set-up to measure actively (with an external source or corner cube) or passively 
(using external stray light, solar energy, or an object that is at an elevated temperature of at least 10C 
than ambient temperatures.  Typically, it is more difficult although not impossible to quantify without 
and external source if the pathlength is not known. 
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Figure 8.4  Bistatic and Monostatic Open Path Configurations 
 
The advantage of open-path systems is that they can be set-up to measure over very long optical 
pathlengths typically 1000 meters.  The longer the pathlength, the lower the detection limit of the target 
compound being measured.  The disadvantage is that interferences, typically ambient moisture and 
carbon dioxide can quickly saturate in their regions making it impossible to measure detector response 
in those regions (see Figure 8.6).  It is important to understand that the FTIR will measure molecules 
with the pathlength between the detector and source but the software will report the same number for 
a small plume of higher concentration (e.g. 100 ppm over a 1 meter pathlength) as a low concentration 
plume over a longer pathlength (10 ppm over 10 meters) and is illustrated schematically in Figure 8.5. 
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Figure 8.6   Open Path FTIR Spectra: A) with active source, B) active 
source off 
 
From Figure 8.6, it is easy to see that the total energy available for measurement is drastically different 
with the source on versus the source off.  It is important to ensure proper alignment of the system to 
the source when performing open-path measurements. 
 
The openpath systems typically use an Illuminator M-series spectrometer mounted to a 10 or 12” 
Newtonian telescope with a Field of View (FOV) of 3 mrads.  The Illuminator is detachable and can be 
used separately.  The telescope is only used to collect photons over longer distances. 
 
The Aires Open-Path monitoring system is a combination of an extractive fixed pathlength and open-
path system.  The pathlength is fixed at 80 meters or 105 meters and the shroud or hardcover can be 
pulled up over the optics so that the pathlength can be filled with nitrogen or air to collect a 
background.  It is then run exactly as an extractive system. 
 
Aligning the Source: 
 
The longer the distances used in openpath measurements, the more difficult it is to focus the telescope 
onto the “hot” source.  Typically, alignment is performed using a “rifle-scope” mounted on the 
telescope and source.  These need to be periodically aligned to aid in finding the source over long 
distances.  The procedure to do this is to place the telescope and source or corner cube at a shorter 
distance than that used in the field (e.g. 100 meters).  Adjust the legs of each tripod until the leveling 
bubble is directly in the center of the reference circles on each tripod.  Put the instrument in the 
“Align” mode (see Chapters 4 and 6) and set the align resolution to 32 cm-1 to update the system 
faster.  View the inteferogram and singlebeam spectrum and adjust the telescope tripod gears up and 

 



down and side to side until the maximum inteferogram is achieved and the energy at the higher regions 
(2000-4500 cm-1) of the single beam come up in energy (y-axis direction).  Once the maximum is 
achieved, dial in the rifle scopes on both components so that the cross-hairs are focused directly onto a 
reference point on each component.  When the components are moved to farther distances, the system 
will be easier to align.  Other devices such as laser pointers or GPS may be used.  Distances may be 
calculated to determine pathlength at the discretion of the user. 

 
Figure 8.7 

 



 
Figure 8.8 
 
Collecting a Background: 
 
It is generally more difficult to collect a background with an open-path system versus an extractive unit 
because you cannot effectively fill the entire pathlength with an infrared invisible gas such as nitrogen.  
There are several techniques to perform backgrounds that are beyond the scope of this manual. Please 
contact MIDAC’s applications department for more specific questions on techniques and 
methodologies. 
 
Typical background techniques involve: 
 

1. Collecting a background upwind of the sample area that does not contain the target compounds 
of interest but at the same pathlength. 

2. Using a synthetic or spectral manipulation package to remove target compound bands of 
interest from a single beam spectrum collected at the sampling site and using that as the 
background. 

3. Using the “Single Beam Quant” option in the  AutoQuant Pro© Software.  Using this function 
under Parameters-Methods-Synthetic Single Beam Quant (SBQ) essentially uses the endpoints 
selected for quantification for each target compound in the method.  The software will then use 
the collected single beam spectrum and draw a straight line between these points and use the 
new single beam as the background spectrum.  This is essentially doing the same thing as 
manually “zapping” out the target compound bands using Grams software.  It is important to 

 



select the endpoints carefully and the same for each reference spectrum so that the energy 
represented by the single beam spectrum matches the sample spectrum. 

 
 
Quantification: 
 
Reference spectra collected with an extractive fixed pathlength system can be used as reference spectra 
for open-path calibrations.  Library spectra may also be used.  Field generated spectra may also be used 
with a 1 meter sample cell placed in the open-path beam.  Please refer to EPA/625/R-96/010B 
Compendium of Methods for the Determination of Toxic Organic Compounds in Ambient Air - TO-
16 for more information on Open-Path measurements. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



Chapter 9 
Troubleshooting 
 
In this chapter we will address the most common problems encountered by users.  In most cases, these 
problems are caused by incorrect instrument setup, and are readily solved using the procedures outlined 
here. 
 
Problem: My temperature and pressure readings are incorrect or temperature and pressure are not 

read by the software. 
 
Fix: If the temperature and pressure readings are incorrect, the first thing to check is that the 

units are correctly specified in the peripheral setup.  Readings of 14.7 atmospheres or 
1.007 psi can result if the units are incorrectly entered.  If this does not fix the problem 
then the user should identify whether the system uses fiber optic communication or 
Watlow via RS-232 and follow the appropriate steps given below. 

 
Watlow: First check that the settings on Parameters – Cells – Setup are correct.  The port 

should usually be COM1 and the baud rate is 19200.  If these are correct and the 
problem still persists then we need to configure the controller itself by taking the 
following steps: 

 
Temperature: 
 

1) Access the setup page on the controller.  This is achieved by holding the up and down buttons 
simultaneously for 6 seconds.  After 3 seconds a menu will appear, continue to hold and the 
setup page will become active. 

2) Using the up and down keys select input 1 (InP1) 
3) Using the advance key select sensor type (SEn1) 
4) Using the up and down keys select the thermocouple input (tc) 
5) Using the advance key select sensor type (in 1) 
6) Using the up and down keys select thermocouple (J) 
7) Using the advance key select range low (rL 1) and enter minimum temperature 0C 
8) Using the advance key select range high (rh 1) and enter maximum temperature 240C 
9) Use the advance key to return to input 1 (InP2) 
10) Using the up and down keys select output 4 (out 4) 
11) Using the advance key select baud rate (baud) 
12) Using the up and down keys select 19.2k 
13) Using the advance key select  address (addr) 
14) Using the up and down keys enter 1 
15) Use the advance key to return to output 4 (out 4) 
16) Use the up and down keys to select the global menu (glbl) 
17) Use the advance key to select (C/F)  
18) Use the up and down keys to select C for units 
19) Press the home key to take you back to the beginning 
20) Use the advance key to select auto tune (Aut) 
21) Use the up and down keys to select tune (tunE) 
22) Press the advance key 3 times to select the temperature parameters 

 



23) Use the up and down keys to select the desired auto tune temperature 
24) The red display will start to blink.  The tuning process takes approx. 10 minutes. 
25) The temperature setting procedure is complete. 
 
Pressure: 

 
1) Access the setup page as described earlier 
2) Using the up and down keys select input 1 (InP1) 
3) Using the advance key select sensor type (SEn1) 
4) Using the up and down keys select process input (Proc) 
5) Using the advance key select input 1 type (In 1) 
6) Using the up and down keys select the 4-20 mA input (4-20) 
7) Using the advance key select decimal (dEC 1) 
8) Use the up and down keys to select 0.00 
9) Use the advance key to return to range low (rL 1) 
10) Use the up and down keys to select 0.00 
11) Use the advance key to get to range high (rh 1) 
12) Use the up and down keys to select 30.00 
13) Use the advance key to return to input 1 (InP1) 
14) Using the up and down keys select output 4 (Out 4) 
15) Using the advance key select baud rate (baud) 
16) Use the up and down keys to select 19.2k 
17) Using the advance key select address (addr) 
18) Using the up and down keys enter 2 
19) Use the home key to exit setup.  The controller should be reading approx. 14.7 psi.   
20) The pressure setting procedure is complete 
 
 
 

Fiber Optic: First check that the fiber optic cables are correctly connected to the fiber card in the 
computer by reversing the cables.  If this does not correct the problem the 
following steps should be taken: 

 
Access the fiber optic setup using Parameters – Cells.  Enter the set of parameters shown in Figure 
8.1.  You may need 50 instead of 30 for the pressure high value depending on transducer equipped. 
 

 
Figure 8.1  Fiber Optic Setup 
 

 



Ensure that the default temperature, pressure and flow boxes are unchecked.  If the problem persists 
after the apparatus is tested, please contact MIDAC applications support. 
 
Problem: The throughput in align mode has dropped to unacceptable levels. 
 
Fix: If applicable check the liquid nitrogen levels in the detector Dewar.  If the detector is 

topped up and the throughput is still low the cell optics should be checked for deposits 
on the mirrors.  Deposits are often formed when cell temperature is too low to prevent 
condensation on the mirrors.  In order to check the mirrors it is necessary to remove 
the end plate from the cell.  This should be done carefully as the mirrors are directly 
attached to the end plate on most cells.  Access the second set of mirrors by removing 
the cell from the instrument casing.  If deposits are found the mirrors should be washed 
by squirting the surface with polar (methanol) and non-polar (methylene chloride) 
solvents in an effort to dissolve the contaminants.  Acetone also works well to dissolve 
non-polar deposits.  Do not directly touch the mirror surface.  ON NO ACCOUNT 
SHOULD ACIDS BE USED ON THE MIRRORS.  This will result in severe 
damage to the gold coating.  After washing, the mirrors should be blow dried with dry 
nitrogen or acetone and inspected.  If the deposits have been mostly cleared by washing, 
the cell should be reassembled and the instrument throughput checked.  If insoluble 
deposits still remain, it may be necessary to take further cleaning steps.  The mirror 
coating is extremely delicate, and may be scratched even by a light touch, and so 
rigorous care must be taken to avoid directly touching the gold surface.  There is 
however a procedure that has been found to give good results, although MIDAC can 
accept no responsibility for any damage caused while following this procedure.  The 
mirrors should be immersed in clean de-ionized water.  While fingers should never 
touch the coating directly, if a layer of Ivory soap is applied to the fingertip it is possible 
to gently wipe the surface without damage.  Ivory soap is used due to its lack of 
additives.  The mirrors should then be rinsed and dried.  The cell should then be 
reassembled and the throughput checked.  If the instrument throughput is still 
unsatisfactory, it may be necessary to re-align the fixed mirror, as described in Chapter 
6.  It should be noted that this procedure is unsuitable for inexperienced operators.  If 
in doubt, call MIDAC applications support. 

 
 
 
 
 
 
 
 
 
 

 



 
 
Appendix 1 
 
CLS Summary 
 
In many cases, a linear model of infrared absorbance known as Beer’s Law provides useful estimates of 

gaseous concentrations in mixtures of gases.   A classical least squares (CLS) technique, described 

below, is useful for generating these estimates from a measured sample spectrum and a number of 

reference spectra representing the sample gas constituents. 

 

The measured absorbances of certain compounds do not follow Beer’s Law over large ranges of 

concentration.  Two mathematical methods that can be used in such cases to obtain approximate 

concentrations are described below.  The first method, referred to here as piece-wise concentration 

interpolation (PWCI), is based on 1) the concentrations of two reference spectra, 2) the results of two 

independent CLS analyses, each of which uses a single reference spectrum for the compound, 3) a 

concentration-based interpolation involving an empirically determined parameter.  The second method, 

referred to here as a pair-wise absorbance interpolation (PWAI), is based on 1) the concentrations of 

the two reference spectra, 2) the results of a single CLS analysis using the two reference spectra, and 3) a 

linear model describing the sample absorbance of in terms of the absorbance of a pair of the compound’s 

reference spectra at each infrared frequency.  

 

The determination of accurate residual spectra and concentration uncertainties is problematic within 

the PWCI approximation, since it requires the performance of two independent CLS analyses; it is not 

clear how these independent results should be combined to provide the residual spectra and 

uncertainties.  In contrast, the PWAI approximation, which is based on a single CLS analysis, provides 

clearly defined residual spectra and concentration uncertainties. 

 

In several other aspects regarding the determinations of concentration in single-component spectra of 

CO2, the PWAI method is shown below to yield concentration estimates superior in most regards to 

those of the PWCI method.  The accuracy advantage of the PWAI approximation  over the PWCI 

approximation is particularly marked when the number of reference spectra is limited.    

 

 



CLASSICAL LEAST SQUARES (CLS) ANALYSIS 

 

Definitions of Beer’s Law and the CLS Parameters 

Fourier transform infrared (FTIR) spectrometers provide data suitable for the determination of 

unknown concentrations of individual compounds in multi-component samples.  For gas samples, 

FTIR-based quantitative analyses are usually based on a linear model of the sample absorbance known 

as Beer’s Law, which can be written as  

∑
=

=
M

1j
jiji CLaA   ,  i = 1, 2, .....N Eq. (1) 

 

where 

M  = The number of compounds assumed to absorb in the spectral region analyzed 
(with index j); 

iA  = The number of infrared frequencies used in the analysis (with index i); 

N  = The observed sample absorbance at the ith infrared frequency; 

jC  = The (unknown) volumetric concentration of the jth component of the mixture; 

L  = The absorption path length used in recording the sample spectrum; 

ija  = The absorptivity of the jth compound at the ith infrared frequency. 

 

The absorptivities a are characterized, though not necessarily directly calculated, in spectroscopic 

studies of the compounds of interest under well-known conditions.  Information regarding the 

absorbance of each compound is usually embodied in a library of “reference” or “standard” spectra. 

ij

 

The “classical least squares” (CLS) approach to determining the desired concentrations C , as defined 

in this work, involves minimizing the squared errors associated with Equation 1.  The basic approach is 

thoroughly described in a series of papers written by David Haaland and co-workers.

j

1, 2, 3 

This work employs the following expression of Beer’s Law:  
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S++  +  γεβνα   ,  i = 1, 2, .....N Eq. (2) 

 

where 

 



A i
S  = measurements of the sample absorbance at the frequenciesν ; i

iν  = infrared frequency of the ith absorbance point within the “analytical 
region” selected for the analysis; 

i + βνα  = linear baseline correction to Beer’s Law for the selected absorbance 
points (see below); 

ε i  = Deviations from Beer’s law (or the model “errors”) including those 
related to the baseline corrections, at the frequencies ν i ; 

jS  = “scaling factor” for the jth reference spectrum included in the analysis; 

ijγ  = “reduced absorptivity” of the jth reference spectrum at the ith absorbance 
point within the “analytical region” (see below). 

 
Two quantities found in Equation 2 require further description. 

 
First, the quantity ijγ  is defined as the “reduced absorptivity” of the jth reference spectrum at the ith 

frequency (ν ).  In terms of experimentally available parameters, this quantity is i

 AR
ij R

jjj

j
ij CpL

T
=γ  Eq. (3) 

 

where 
R
ijA  = absorbance of a single reference spectrum of the (pure) jth compound at the 

frequenciesν ; i

jT  = absolute temperature (Kelvin) at which was recorded; R
ijA

jL  = absorption path length (meters) at which was recorded; R
ijA

jp  = absolute pressure (atm) at which was recorded; R
ijA

R
jC  = volumetric concentration (ppm) at which was recorded. R

ijA

 
The reduced absorptivity ijγ  of Equation 3 is a representation of the absorptivity after normalization 

for the effects of the reference gas density, reference gas pressure, reference absorption pathlength, and 

reference gas volumetric concentration.  In the following arguments, it is assumed that the 

values

ija

ijγ require no additional corrections for baseline effects.  

 

Second, the terms α  in Equation 2 represent a linear baseline correction to Beer’s Law in the 

sample spectrum over the frequencies

i + βν

iν .  An extension to higher (nth) order baseline corrections is 

 



possible with the inclusion of similar terms proportional to .  Such terms are excluded from the 

mathematical arguments presented below.  
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CLS Estimates of the Concentrations, Baseline Parameters, and Uncertainties 

Equation 2 provides accurate CLS estimates of the parameters α β ,  , and the scaling factors Sj.  These 

estimates are denoted below by α , β , and jS , and are calculated as follows.4 

 

The “design matrix” D with M+2 columns and N rows is defined as  
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D  Eq. (4) 

 

Each the first M columns of D corresponds to the jth compound, and consists of the N values γij.  The 

(M+1)th column consists of  N entries of any non-zero constant, representing the constant baseline 

offset term , the (M+2)α th column consists of the N values .  If the row vector  represents the N 

measured (“sample”) values, the column vector X represents the M+2 unknown quantities {S

SA

1, S2,...SM, 

, β }, and the row vector E represent the N errors α ε i , the linear model in Equation 2 takes the form  

EDXAS +=  Eq. (5) 

 

The matrix Equation 4 is over-determined, that is, there are more absorbance values (N) available than 

there are parameters (M+2) to be estimated.  To proceed, it is necessary to assume that the errors ε i  

posses a joint distribution with zero means and a variance-covariance matrix of the form  
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  . Eq. (6) 

 

 



It is worth noting that generating valid least-squares parameter estimates is possible without assuming a 

normal distribution of the errors ε .  However, it is necessary to assume further that Mi f is known only 

to within a scaling factor , that is,  σ2

M Nf = σ 2   . Eq. (7) 

 

Under these conditions, where the matrix transpose is denoted by the superscript t and the matrix 

inverse by the superscript –1, the desired least squares estimates of the quantities X are given by  

( ) S-1t1-1t ANDDND=X −
  . Eq. (8) 

 

The matrix N  is the “weight matrix.”  In the simplest case (when all the observed quantities A-1

σ

i have 

equal variance ),  is accurately approximated by the identity matrix I.  In this case , and 

Equation 8 simplifies to the form used below: 

2 N-1 IM 2
f σ=

( ) S
t1t ADDD=X −

  . Eq. (9) 

 

Measures of the “uncertainties” in the least squares estimates X are also available.   The residual vector 

(or “spectrum”) is  

XD-AV S=   . Eq. (10) 

 

V is (at each frequency) the difference between the measured absorbance  and the least squares 

estimate 

SA

XD .  From V, a least-squares estimate of the moment matrix M  is available: f

( ) 1t
t
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=
3MNf  Eq. (11) 

 

and the marginal standard deviations j∆ (often referred to as the “1σ uncertainties”) in the parameter 

estimates jX  are given by  

jjfj )( M=∆   . Eq. (12) 

 

 



Please note that the denominator (N-M-3) of Equation 11 reflects the use of a linear baseline 

correction.  In general the denominator is (P-Q-1), where P is the number of data (absorbance) points 

and Q is the total number of parameters determined in the CLS analysis. 

 

The least squares estimates of the concentrations Cj are given in terms of the first M values of jX  by  

j

SS

S
j S

pL
TC =  Eq. (13) 

where  

 

SL  = absorption path length (meters) at which A was recorded; i
S

ST  = absolute temperature (Kelvin) at which was recorded; A i
S

Sp  = absolute pressure (atm) at which was recorded; A i
S

jS  = the least squares estimates of the scaling factors, contained in the first M 
elements of the vector X . 

 

Similarly, an unbiased 1σ estimate of the uncertainty U  in each of the concentration estimates is given 

in terms of the marginal standard deviations by 

j

j
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Appendix 2 
 
AQPro Socket Interface 
 
AQPro exposes an interface to allow it to be controlled by remote clients via standard 
network TCP/IP sockets. It uses port number 5000. This allows AQPro to be controlled 
by other programs, or interactively by remote users over the network.  If, for security reasons, you 
don’t want AQPro to enable this interface, add the ‘/noserver’ flag to the command line of the shortcut 
that starts AQPro. 
 
Interactive Usage. 
Telnet can be used to control AQPro via the socket interface. First start AQPro, then run 
‘telnet localhost 5000’ if AQPro is running on the same machine, or ‘telnet IPADDRESS 
5000’ if AQPro is running on a different machine. The IP Address can be determined by 
running the windows ‘ipconfig.exe’ program on the machine where AQPro is running. 
The IP address has a format like ‘192.168.0.5’. Telnet will then connect to AQPro, which 
will respond by sending back the string ‘AQPro A.B.C.D’, where A.B.C.D. is the build 
number of the version of AQPro. Then, type ‘echo’ followed by Enter and AQPro will be 
friendlier to use interactively, and you will then see the prompt ‘AQPro>’. . (AQPro does 
not automatically echo back commands because programs, not people, usually drive the 
socket interface). 
 
Programmatic Usage 
An example Visual Basic client project is available. This project presents a simplified 
user interface with just Background, Scan, and Analyze buttons. It illustrates how to build 
a remote control socket client for AQPro. 
 
Command Set 
 
If you type ‘?’ at the AQPro> telnet prompt, you will see: 
Supported Commands: 
 
loadMethod <name> load AQPro method specified by ‘name’ 
path <directory> set the collection directory to ‘directory’ 
 
calibrate calibrate the current method 
 
break attempt to break out if the server appears hung 
 
background collect a new background 
 
loadBackground <name> load a background datafile from disk. 
 
scan collect a new sample 
 
getLastFilename returns the filename of the last collected data 
analyze analyze the last sample 

 



 
batch analyze all the samples since the last background 
 
echo [0,1] turn echo on (1) or off (0). Defaults to ‘on’ 
 
exportImage copy the instrument view's data window to the clipboard 
 
format <csv,xml> set the format of analysis results 
 
beginCollect <single, continuous, highspeed, automatic> begins data collection and analysis in the 
given mode. 
 
endCollect stops a collection begun with beginCollect (if one is in progress). 
 
getTemperature returns the last-read temperature value, in Celsius 
 
getPressure returns the last-read pressure value, in ATM. 
 
getFlowrate returns the last-read flowrate value, in CFM. 
 
stop terminates the socket connection 
 
Commands are not case sensitive. Commands must be terminated with carriage return / 
line feed codes. 
 
The ‘loadMethod’, ‘path’, ‘loadBackground’, and ‘format’ commands require arguments, 
which is specified in the list above with the ‘<>’ notation. Do not include the ‘<’ and ‘>’ 
in the command. 
 
In the case of loadMethod, the argument is the filename of the method. This can be the 
full path of the method: 
 
C:\Documents and Settings\All Users\Documents\AutoQuant4\methods\ex2\ex2.aq4 
Fortunately, this can be shortened. 
 
You can always leave off the .aq4 extension, the software will add it if needed. 
If the method is in the default method directory, which is set on the 
Tools/Parameters/Paths dialog in AQPro, then the argument can be shortened to: 
ex2\ex2  This can be shortened even more. If the method is in the default method directory, and the 
base method filename (the filename without the .aq4 extension) is same as the name of the subdirectory 
it is in, just specify the name of the subdirectory: 
ex2  Data collected through the socket interface is always saved to disk, regardless of the 
method’s storage settings. The path command tells AQPro where to put data that is 
collected. The directory is created automatically if it does not exist. Data is saved in the 
GRAMS file format as floating-point numbers. 
 
The format command has two options: csv or xml. The default is xml. Csv (Comma 

 



separated Values) format is very terse. Each compound’s results are given by a comma separated triple: 
compoundName, concentration, uncertainty. All the compound triples 
for a sample are returned on one line. The csv format is a standard way of importing data 
into programs such as excel and is easily parsed by software. The XML (Extensible 
Markup Language) format is the internal representation of results that AQPro uses and is 
very verbose, containing a lot of additional information. XML is an industry-standard 
format for data interchange; much information about it is freely available on the Internet. 
The results generated by ‘analyze’ or ‘batch’ will be returned in the specified format. 
The echo command takes optional arguments (specified with the ‘[‘ and ‘]’ enclosures). 
Do not include the ‘[‘ or ‘]’ in the command. With no argument, it turns echo on. 
 
Note that the ‘exportImage’ command exports the spectral data plot from AQPro’s 
instrument view to the clipboard of the host computer (the one that AQPro is running 
on). This is of no benefit if you are controlling AQPro from a remote computer. 
GetTemperature, getPressure and getFlowrate return the last-read values for these 
parameters. These values are read at times defined in the method. The handlers for these 
commands do not go to the sensors and request new values. Rather, they return the values 
that were latched the last time they were read in the course of a measurement.  
 
In versions of AutoQuant Pro© build 99 and higher a new socket monitor called xmlSocket.mon is 
available.   On the Tools/Parameters/Monitors dialog, click 'Browse' and select  
'xmlSocket.mon'.  This monitor streams all reported concentrations, uncertainties and alarms out of the 
TCP port in xml format.  Xml is a standard format for data interchange, and this output may be parsed 
by custom software built to read the xml data.  After selecting the xml monitor into an aqpro method 
and starting a measurement,  it is possible to connect to the socket by typing 'telnet localhost 20000' 
from a command line on the same computer.  An example of a Telnet session is given below: 
 
AQPro 4.0.0.107 
> AQPro> getTemperature 
> 90.000000 
> AQPro> getPressure 
> 1.000000 
> AQPro> beginCollect continuous 
> OK, collect message sent 
> AQPro> 
 
  Localhost is a stand-in for the local computer's IP address.  20000 is the default TCP port for the xml 
socket monitor.  The xml socket may then be accessed from any computer on the network, as long as 
the IP address for that computer is substituted  for 'localhost'. 
  
 
 
 
 
 
 

 



 
Appendix 3 
Hydroquant 

 
The HydroQuant method of FTIR gas analysis was developed at MIDAC for the specific application of 
measuring moisture in corrosive gases.  The hardware typically used is includes an I-series spectrometer 
that is evacuated to lower than 10-3 torr to remove all background moisture and gases.  Because of the 
corrosive and dangerous nature of most sample gases, a technique had to be developed that allowed 
data to be taken without collecting a background spectrum.  Also since very low levels of moisture are 
to be measured, even small amounts of water in the background could adversely affect results. 
 
The HydroQuant algorithm creates a synthetic background from each sample interferogram.  The 
sample interferogram is multiplied by a Gaussian function that can be described as: 
 

−








x
ke

2

2

  
After multiplying the interferogram by this function, the resulting interferogram has been smoothed 
out.  The function approaches zero as you travel down the wing of the interferogram.  The resulting 
single beam is a smooth instrument response profile without the sharp lines from the water.  It is very 
similar to a fully purged system background. 
 

 
FIGURE:  A sample single-beam (top) and its corresponding synthetic background (bottom) are 
shown.  The sample is air and was collected at 2cm-1, 256 scans with a K-value of 1200.  
 
The k value is a user selectable parameter to modify the behavior of the Gaussian function.  The higher 
the K-value, the faster the Gaussian decays and the more deresolved the interferogram appears.  
Researchers at a national lab as well as customers in the gas supply industry typically use a k-value of 
1200 with samples collected at 2.0 cm-1 with 256 or more co-added scans. 
 

 



In doing analysis with this type of method, it is very important to keep the k-value consistent.  The 
method should have spectra processed with the same k-value as the sample spectra because the k-value 
will ultimately affect the shape and intensity of the absorbance peaks. 
 
Using a synthetic background saves an enormous amount of time that would be required to generate a 
background spectrum. Typical moisture analysis consists of low ppb measurements, and it would take 
many hours to dry a gas cell to below that level.  This approach works great with compounds with 
narrow features.  Although it is referred to as “HydroQuant”, it has been used to monitor other sharp-
band compounds like HF and other acid gases.  However, this method does not work well with broad 
band compounds. 
 
 

 



Appendix 4 
 
Jumper Settings 
 
Below is a table for the 102818 mirror drive board jumper configuration for 
the various scan speeds.  The corresponding dual 102713 ADC filter settings 
for J1 or J2 are listed in actual layout form as found on the board. 
 

102818 Mirror Drive Board 
JMP4 Mirror Speed Adjust Headers 

(shaded values not currently available) 

102713 Dual 
ADC Board 
Filter (kHz) 

(X=jumper, O=open) MIRROR 
SPEED (kHz) 

 
 

J1 
OOO 469  156  
OOX 234  88  
OXO 117  48  
OXX 59  27  
XOO 29  16  
XOX 15  8.8  
XXO 7  4.8  
XXX 4  2.7  

 J2 
  
 ZPD adjustment is similar to previous boards. 
 

102818 ZPD DELAY ADJUSTMENT (JMP1) 
(Adding jumpers decreases zpd by the indicated # of points) 

     

M
SB

 

4096 2048 1024 512 256 

LSB 

 
● New grounding scheme:  The interferometer is no longer isolated from 
chassis.  The gray silpad found between interferometer and base plate has 
been removed. 

 
● Detector modules are now isolated from the chassis.  Nylon dowel pins 
and nylon mounting screws are used with an isolation pad to prevent 
electrical contact with the chassis.   
 
● Laser gain/test points:  Laser gain jumpers are still adjusted in pairs, now 
with two separate groups of headers: JMP2 and JPM3.  There are now three 
jumper settings for each channel.  As before, removing jumpers increases 

                                                        161 



gain.  For ground you can use the indicated test points or any metal contact 
(mounting screws, chassis, etc.)  
Note:  Peak-to-peak laser signal can reach a maximum of approximately 11 
volts before clipping occurs. 
 
● The new mirror drive board can function with power supplied through the 
ribbon cable when used with old/single ADC systems.  Removing the 
indicated jumpers and using the auxiliary 3-terminal phoenix connector with 
the new power distribution board will provide improved mirror scanning 
stability.  
 

                            Interferometers with the new 102818 (Rev E and up) mirror drive boards 
will stroke without computer communication.  
 
● Interferometers with the old combo mirror drive boards can still be used 
with Dual ADC systems.  The J2 jumpers must be in the upper position (old 
fiber optic setting) and the isolation silpad should be removed. 
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